Send Us Your Comments

Preface

1 Oracle Complex Maintenance, Repair, and Overhaul Overview

Overview ........................................................................................................................................ 1-1
Overview of Oracle Complex Maintenance Repair and Overhaul ........................................ 1-1
  Maintaining Complex Configurations ...................................................................................... 1-2
  Effectively Planning Enterprise-Wide Operations .................................................................. 1-2
  Optimizing Maintenance Execution ....................................................................................... 1-2
  Centrally Managing All Engineering Data ............................................................................ 1-3
Oracle CMRO Module Overview ............................................................................................... 1-3
  Automatic Visit Scheduling and Auto-Packaging ................................................................ 1-3
  Route Management ................................................................................................................. 1-4
  Document Index ..................................................................................................................... 1-4
  Enigma Integration ................................................................................................................ 1-4
  Fleet Maintenance Program ................................................................................................ 1-5
  Master Configuration ............................................................................................................. 1-5
  Unit Configuration ................................................................................................................. 1-5
  Product Classification .......................................................................................................... 1-6
  Unit Maintenance Plan ......................................................................................................... 1-6
  Visit Work Package .............................................................................................................. 1-6
  Long Term Planning ............................................................................................................ 1-6
  Production ............................................................................................................................ 1-6
  Production Planning ........................................................................................................... 1-7
  Outside Processing for Work Orders .................................................................................... 1-7
  Outside Processing for Inventory Service Orders ............................................................... 1-7
2 Setting Up

Overview......................................................................................................................... 2-1
Getting Started............................................................................................................... 2-1
Oracle CMRO Implementation Checklist................................................................. 2-2
Setting Up Oracle CMRO............................................................................................. 2-7
Setting Up Other Related Oracle Applications....................................................... 2-7
  Setting Up an Organization....................................................................................... 2-8
  Setting Up Oracle Inventory..................................................................................... 2-25
  Setting Up Oracle Bills of Material (BOM)............................................................... 2-36
  Setting Up Oracle Warehouse Management......................................................... 2-39
  Setting Up Oracle Purchasing.................................................................................. 2-44
  Setting Up Oracle Advanced Planning and Scheduling....................................... 2-47
  Setting Up Oracle Order Management.................................................................. 2-49
  Setting Up Oracle Projects...................................................................................... 2-51
    Verifying and Updating the Project Created in the CMRO Visit Work Package .... 2-52
  Setting Up Oracle Enterprise Asset Management................................................. 2-53
  Setting Up Oracle Service....................................................................................... 2-56
  Setting Up Oracle Contracts................................................................................... 2-62
  Setting Up Oracle Installed Base............................................................................ 2-64
  Setting Up Oracle Counters.................................................................................... 2-66
  Setting Up Oracle Quality....................................................................................... 2-66
    Setting Up Route and Operation Quality Plans..................................................... 2-66
    Setting Up Job Deferral, MRB Disposition Quality, Non-Routine Job Inspection and
    Non-Routine Operation Inspection Plans............................................................... 2-70
    Setting Up Counter Readings Quality Plans......................................................... 2-71
CMRO Specific Setups................................................................................................ 2-72
  Oracle Complex Maintenance, Repair, and Overhaul Standard Setup.................. 2-73
  Oracle CMRO Approval Workflow Setup................................................................ 2-77
Oracle CMRO Module Setup...................................................................................... 2-85
  Setting Up Automatic Visit Scheduling and Auto-Packaging............................... 2-86
    Defining Service Categories................................................................................. 2-87
    Defining Flight Categories.................................................................................... 2-88
    Defining Visit Type Lookups................................................................................ 2-89
    Defining Visit Type Profiles................................................................................. 2-90
    Defining Primary Maintenance Requirements.................................................... 2-91
    Defining Maintenance Organizations Used in Auto Visit Planning.................... 2-92
    Defining Maintenance Departments................................................................... 2-94
  Setting Up Complex Assembly Maintenance....................................................... 2-96
    Prerequisites for Complex Assembly Maintenance............................................. 2-96
Setting Up Document Index................................................................. 2-99
Setting Up Route Management......................................................... 2-101
Setting Up Master Configurations.................................................. 2-107
Setting Up Unit Configurations....................................................... 2-109
Setting Up Fleet Maintenance Program.......................................... 2-115
Setting Up the Unit Maintenance Plan............................................. 2-117
Setting Up Visit Work Package...................................................... 2-119
Setting Up Long Term Planning..................................................... 2-122
Setting Up Production...................................................................... 2-124
Setting Up Inventory Service Order Outside Processing.................. 2-127
Administrative Setup........................................................................ 2-132
Setting Up Enigma Integration....................................................... 2-135
Setting Up Supplier Warranty......................................................... 2-137

A Windows and Navigation Paths

Windows and Navigation Paths.......................................................... A-1
Default Navigation Paths for Standard Application Windows............... A-1

Index
Send Us Your Comments

Oracle Complex Maintenance, Repair, and Overhaul Implementation Guide, Release 12.2
Part No. E49040-02

Oracle welcomes customers' comments and suggestions on the quality and usefulness of this document. Your feedback is important, and helps us to best meet your needs as a user of our products. For example:

- Are the implementation steps correct and complete?
- Did you understand the context of the procedures?
- Did you find any errors in the information?
- Does the structure of the information help you with your tasks?
- Do you need different information or graphics? If so, where, and in what format?
- Are the examples correct? Do you need more examples?

If you find any errors or have any other suggestions for improvement, then please tell us your name, the name of the company who has licensed our products, the title and part number of the documentation and the chapter, section, and page number (if available).

Note: Before sending us your comments, you might like to check that you have the latest version of the document and if any concerns are already addressed. To do this, access the new Oracle E-Business Suite Release Online Documentation CD available on My Oracle Support and www.oracle.com. It contains the most current Documentation Library plus all documents revised or released recently.

Send your comments to us using the electronic mail address: appsdoc_us@oracle.com

Please give your name, address, electronic mail address, and telephone number (optional).

If you need assistance with Oracle software, then please contact your support representative or Oracle Support Services.

If you require training or instruction in using Oracle software, then please contact your Oracle local office and inquire about our Oracle University offerings. A list of Oracle offices is available on our Web site at www.oracle.com.
Preface

Intended Audience

Welcome to Release 12.2 of the *Oracle Complex Maintenance, Repair, and Overhaul Implementation Guide*.

See Related Information Sources on page ix for more Oracle E-Business Suite product information.

Documentation Accessibility

For information about Oracle's commitment to accessibility, visit the Oracle Accessibility Program website at http://www.oracle.com/pls/topic/lookup?ctx=acc&id=docacc.

Access to Oracle Support

Oracle customers have access to electronic support through My Oracle Support. For information, visit http://www.oracle.com/pls/topic/lookup?ctx=acc&id=info or visit http://www.oracle.com/pls/topic/lookup?ctx=acc&id=trs if you are hearing impaired.

Structure

1. *Oracle Complex Maintenance, Repair, and Overhaul Overview*
2. Setting Up
   A. Windows and Navigation Paths

Related Information Sources

Oracle Complex Maintenance, Repair, and Overhaul shares business and setup information with other Oracle Applications products.

*Oracle E-Business Suite User's Guide*
This guide explains how to enter data, query, run reports, and navigate using the graphical user interface (GUI). This guide also includes information on setting user profiles, as well as running and reviewing reports and concurrent processes. You can access this user's guide online by choosing "Getting Started with Oracle Applications" from any Oracle Applications help file.

Oracle Inventory User's Guide

This guide describes how to define items and item information, perform receiving and inventory transactions, maintain cost control, plan items, perform cycle counting and physical inventories, and set up Oracle Inventory.

Oracle Bill of Materials User's Guide

This guide describes how to create various bills of material to maximize efficiency, improve quality, and lower costs for the most sophisticated manufacturing and maintenance environments. By detailing integrated product structure and processes, flexible product and process definition, and configuration management, this guide enables you to manage product details within and across multiple sites.

Oracle Work in Process User's Guide

This guide describes how Oracle Work in Process provides a complete production management system. Specifically, this guide describes how discrete, repetitive, assemble-to-order, project, flow, and mixed manufacturing environments are supported.

Oracle Order Management User's Guide

This guide describes how to enter sales orders and returns, copy existing sales orders, schedule orders, release orders, create price lists and discounts for orders, run processes, and create reports.

Oracle Enterprise Asset Management User's Guide

This guide discusses maintenance work orders, how to manage them, and eAM's preventive maintenance solution. eAM's integration points and how to use them are described in detail.

Oracle Purchasing User's Guide

This guide describes how to create and approve purchasing documents, including requisitions, different types of purchase orders, quotations, RFQs, and receipts. This guide also describes how to manage your supply base through agreements, sourcing rules and approved supplier lists. In addition, this guide explains how you can automatically create purchasing documents based on business rules through integration with Oracle Workflow technology, which automates many of the key procurement processes.

Oracle Supply Chain Planning User's Guide

This guide describes how to anticipate and manage both supply and demand for your items. Using a variety of tools and techniques, you can create forecasts, load these forecasts into master production schedules, and plan your end-items and their
component requirements. You can also execute the plan, releasing and rescheduling planning suggestions for discrete jobs and repetitive schedules.

**Oracle Projects User’s Guide**

This guide provides instruction on how to set up and use Oracle Projects. If you install Oracle Projects, use this user guide to learn how to enter expense reports in Projects that you import into Payables to create invoices. You can also use this guide to see how to create Project information in Projects which you can then record for an invoice or invoice distribution.

**Oracle Installed Base User’s Guide**

This guide provides an introduction to the concepts, and explains how to navigate the system, enter data, and query information in the Oracle Installed Base interface that forms part of Oracle Complex Maintenance, Repair, and Overhaul.

**Oracle Warehouse Management User’s Guide**

This guide provides information about warehouse resource management, warehouse configuration, and advanced pick methodologies for material handling for warehouses, manufacturing facilities, and distribution centers. This product is one of the components of Oracle Mobile Supply Chain Applications.

**Oracle Installed Base Implementation Guide**

This guide provides information for setting up the contents of many of the lists of values (LOV) that you see in Oracle Installed Base.

**Oracle Quality User’s Guide**

This guide describes how Oracle Quality can be used to meet your quality data collection and analysis needs. This guide also explains how Oracle Quality interfaces with other Oracle Manufacturing applications to provide a closed loop quality control system.

**Oracle Contracts Core Concepts and Procedures Guide**

This guide describes how Oracle Contract can be used to enable companies to author, execute, and manage virtually all business-to-business contracts required by complex global enterprises.

**Oracle Customer Support Implementation Guide**

This guide describes how to set up the list of values that you see in Oracle Customer Support. Oracle’s service solution provides everyone in the organization - with a complete, real-time customer view that allows for immediate access to information on past interactions with the customer and also provides agents with knowledge of possible solutions to speed issue resolution. Additionally, the solution empowers customers to solve their own issues via a self-service portal with access to the same knowledge base that agents utilize for quick resolution.

**Oracle Service Implementation Guide**

This guide describes how to set up Oracle Service.
Oracle Self-Service Web Applications Implementation Guide

This guide contains detailed information about the overview and architecture and setup of Oracle Self-Service Web Applications. It also contains an overview of and procedures for using the Web Applications Dictionary.

Integration Repository

The Oracle Integration Repository is a compilation of information about the service endpoints exposed by the Oracle E-Business Suite of applications. It provides a complete catalog of Oracle E-Business Suite's business service interfaces. The tool lets users easily discover and deploy the appropriate business service interface for integration with any system, application, or business partner.

The Oracle Integration Repository is shipped as part of the E-Business Suite. As your instance is patched, the repository is automatically updated with content appropriate for the precise revisions of interfaces in your environment.

You can navigate to the Oracle Integration Repository through Oracle E-Business Suite Integrated SOA Gateway.

Documents related to Installation and System Administration

Oracle E-Business Suite Concepts

This guide provides an introduction to the concepts, features, technology stack, architecture, and terminology for Oracle Applications. It provides a useful first book to read before an installation of Oracle Applications. This guide also introduces the concepts behind Applications-wide features such as languages and character sets, and Self-Service Web Applications.

Oracle E-Business Suite Installation Guide: Using Rapid Install

This book is intended for use by anyone who is responsible for installing or upgrading Oracle E-Business Suite. It provides instructions for running Rapid Install either to carry out a fresh installation of Oracle E-Business Suite Release 12, or as part of an upgrade from Release 11i to Release 12. The book also describes the steps needed to install the technology stack components only, for the special situations where this is applicable.

Oracle E-Business Suite Upgrade Guide, Release 11i to 12.1.1

Refer to this guide if you are upgrading your Oracle E-Business Suite Release 10.7 or Release 11.0 products to Release 12.1.1. This guide describes the upgrade process and lists database and product-specific upgrade tasks. The instructions in this book apply only to upgrading from Oracle E-Business Suite Release 11i (11.5.9 or later) to Release 12.1.1. If your system is earlier than 11.5.9, then you must upgrade to Oracle E-Business Suite Release 11.5.10 CU2 before you can upgrade to Release 12.1.1.

Maintaining Oracle E-Business Suite

Use this guide to help you run the various AD utilities, such as AutoUpgrade, AutoPatch, AD Administration, AD Controller, AD Relink, License Manager, and
others. It contains how-to steps, screenshots, and other information that you need to run the AD utilities. This guide also provides information on maintaining the Oracle applications file system and database.

**Oracle E-Business Suite Setup Guide**

This guide provides planning and reference information for the Oracle Applications System Administrator. It contains information on how to define security, customize menus and online help, and manage concurrent processing.

**Oracle E-Business Suite Developer’s Guide**

This guide contains the coding standards followed by the Oracle Applications development staff and describes the Oracle Application Object Library components that are needed to implement the Oracle Applications user interface described in the Oracle Applications User Interface Standards for Forms-Based Products. This guide also provides information to help you build your custom Oracle Forms Developer forms so that the forms integrate with Oracle Applications.

**Oracle E-Business Suite User Interface Standards for Forms-Based Products**

This guide contains the user interface (UI) standards followed by the Oracle Applications development staff. It describes the UI for the Oracle Applications products and how to apply this UI to the design of an application built by using Oracle Forms.

**Other Implementation Documentation**

**Oracle Workflow Administrator’s Guide**

This guide explains how to complete the setup steps necessary for any Oracle Applications product that includes workflow-enabled processes, as well as how to monitor the progress of runtime workflow processes.

**Oracle Workflow Developer’s Guide**

This guide explains how to define new workflow business processes and customize existing Oracle Applications-embedded workflow processes. It also describes how to define and customize business events and event subscriptions.

**Oracle Workflow User’s Guide**

This guide describes how Oracle Applications users can view and respond to workflow notifications and monitor the progress of their workflow processes.

**Oracle Workflow API Reference**

This guide describes the APIs provided for developers and administrators to access Oracle Workflow.

**Oracle E-Business Suite Flexfields Guide**

This guide provides flexfields planning, setup and reference information for the Oracle Complex Maintenance, Repair, and Overhaul implementation team, as well as for users responsible for the ongoing maintenance of Oracle Applications product data. This
guide also provides information on creating custom reports on flexfields data.

**Oracle eTechnical Reference Manuals**

Each eTechnical Reference Manual (eTRM) contains database diagrams and a detailed description of database tables, forms, reports, and programs for a specific Oracle Applications product. This information helps you convert data from your existing applications, integrate Oracle Applications data with non-Oracle applications, and write custom reports for Oracle Applications products. Oracle eTRM is available on My Oracle Support.

**Oracle Applications Message Manual**

This manual describes all Oracle Applications messages. This manual is available in HTML format on the documentation CD-ROM for Release 12.

**Do Not Use Database Tools to Modify Oracle E-Business Suite Data**

Oracle STRONGLY RECOMMENDS that you never use SQL*Plus, Oracle Data Browser, database triggers, or any other tool to modify Oracle E-Business Suite data unless otherwise instructed.

Oracle provides powerful tools you can use to create, store, change, retrieve, and maintain information in an Oracle database. But if you use Oracle tools such as SQL*Plus to modify Oracle E-Business Suite data, you risk destroying the integrity of your data and you lose the ability to audit changes to your data.

Because Oracle E-Business Suite tables are interrelated, any change you make using an Oracle E-Business Suite form can update many tables at once. But when you modify Oracle E-Business Suite data using anything other than Oracle E-Business Suite, you may change a row in one table without making corresponding changes in related tables. If your tables get out of synchronization with each other, you risk retrieving erroneous information and you risk unpredictable results throughout Oracle E-Business Suite.

When you use Oracle E-Business Suite to modify your data, Oracle E-Business Suite automatically checks that your changes are valid. Oracle E-Business Suite also keeps track of who changes information. If you enter information into database tables using database tools, you may store invalid information. You also lose the ability to track who has changed your information because SQL*Plus and other database tools do not keep a record of changes.
Overview

Oracle Complex Maintenance, Repair, and Overhaul (CMRO) enables maintenance, repair and overhaul organizations that manage complex configurable and regulated equipment systems, to define, plan and execute every aspect of their maintenance operations such as configuration management, engineering, maintenance planning, and execution. It provides maintenance organizations with the tools required to increase asset turnover, improve response times, and increase service levels. Oracle CMRO is a fully integrated component of Oracle’s eBusiness suite.

This chapter includes the following topics:

- Overview
- Overview of Oracle Complex Maintenance Repair and Overhaul
- Oracle CMRO Module Overview

Overview of Oracle Complex Maintenance Repair and Overhaul

Oracle Complex Maintenance, Repair, and Overhaul is designed to manage the entire business process of defining, planning and executing the maintenance of complex configurable and regulated equipment systems. Improved response times, increased service levels, and faster asset turnaround times are critical to maintaining successful long-term maintenance, repair, and overhaul (MRO) operations. Oracle CMRO offers features such as maintenance-based inventory management, reliability centered
maintenance, a fully web-based architecture, and online access to repair documentation that enable maintenance organizations to maximize efficiency and save costs. By integrating every component of the maintenance, repair, and overhaul operation, Oracle CMRO provides complete real-time visibility across the entire operation.

Oracle CMRO enables organizations to do the following:

- Maintain complex configurations.
- Effectively plan enterprise-wide operations.
- Optimize maintenance execution.
- Centrally manage all engineering data.

**Maintaining Complex Configurations**

Organizations that build or maintain products with complex configurations need to track the configuration history. Oracle CMRO enables you to establish master configurations. Requirements automatically flow to all units based on that master and the history is updated every time changes are made to the configuration. You can combine requirements with actual repair and usage results to provide unit-specific maintenance and configuration history. With this configuration control, you can easily track component history throughout the lifecycle. You can also classify units into smaller groups based on common attributes.

**Effectively Planning Enterprise-Wide Operations**

Maintenance frequency and scope continually change based on usage, new regulatory requirements, and issues discovered during operation. Maintenance plans must be updated periodically to ensure high asset reliability and safety. Oracle CMRO enables comprehensive fleet and unit-based maintenance planning and scheduling. You can establish Fleet maintenance programs to create maintenance requirements and to schedule maintenance activities. You can plan work across all locations to meet both short-term and long-term requirements. By using long-term planning, you can optimize capacity and resource utilization. Concurrently, you can make daily adjustments to respond to changes based on recent activities.

**Optimizing Maintenance Execution**

Oracle CMRO enables you to streamline the execution process and simplify processes such as creating work orders, deploying resources, and updating maintenance history and configurations. Basic maintenance tasks associated with job creation and job completion are automated to increase worker productivity and to minimize aircraft downtime. You can capture results to ensure regulatory compliance and to guarantee traceability. Maintenance history is updated when work is completed. You can enter new service requests and work orders based on additional findings during scheduled
maintenance activities. Oracle CMRO enables component shipping to and from third party maintenance providers. You can also charge costs associated with maintenance activities throughout the repair cycle.

**Centrally Managing All Engineering Data**

Using Oracle CMRO, you can create, store, and manage data centrally. Oracle CMRO enables companies to leverage electronic storage and delivery of technical documentation for real-time access to accurate information and to ensure regulatory compliance. For example, you can capture quality information from all sources (suppliers, original equipment manufacturers, operators, third party maintenance providers) and store it in this single location to ensure traceability. Oracle CMRO provides for route management with reusable templates for individual operation instructions or a series of operations and an integrated document index. By automatically updating all related operations, these templates eliminate the need to perform system queries when route information is changed. Automating these processes eliminates costly manual labor, resulting in higher productivity and improved quality.

**Oracle CMRO Module Overview**

Oracle CMRO enables organizations to streamline maintenance operations, meet the demands for transport and service, and improve profitability. Oracle CMRO includes the following modules:

**Automatic Visit Scheduling and Auto-Packaging**

The automated visit forecasting process is a tool for the maintenance planners to group maintenance requirements together to support both a rough-cut visit plan as well as an operational maintenance plan (Primary Plan), based on a maintenance organization. This enables the planner to approach the plan and focus on the exceptions for both short and long term planning. This feature is used primarily for heavy maintenance such as letter checks and modifications. It is typically used to forecast 12-18 months into the future.

There are two components to the Auto Visit Planning process:

- **Process Flight Visit Schedules API** (Short Term Planning)
- **Create Primary Visits** (Long Term Planning)

**Important:** Only visits with a status of Planning can be used with this feature.

This functionality will improve the creation and scheduling of visits for both line and base maintenance.
For base maintenance, there is a new Autovisit Planning Workbench where users can define a processing hierarchy by master configuration, program type, subtype and a date range. The user can then launch and monitor concurrent programs which will:

- Create new visits based on Primary Visit MRs.
- Cancel existing visits.
- Add UMP MRs to existing visits.

For line maintenance, users can define parameters for creating operational visits based off the flight schedule and maintenance capability of arriving and departing stations. The user can define both generic and specific parameters for flights which will:

- Create pre and post-flight visits.
- Create transit checks which will span an aircraft’s downtime duration.
- Adjust visits based on flight changes.
- Cancel visits based on flight cancellations and re-routes.
- Notify users of changes to specific visits and flight associations.

**Route Management**

Using Route Management, you can maintain work cards in electronic form, so that they are easily accessible. You can use these work cards to provide technicians with task instructions and information on labor estimates, skill requirements, tools, parts, and materials required by the job. You can also remove redundant tasks and processes by storing each task card once in the database and then reusing it in multiple operations.

**Document Index**

Using the Document Index module, you can maintain references to paper documentation and include links that technicians can use to access electronic documents, either in the database or on the Web. You can keep all document references under version control to simplify compliance with regulations. You can also link document references to part types or individual serialized parts to eliminate searches, maintain lists of suppliers, and automatically alert everyone on a distribution list when new documents or revisions arrive.

**Enigma Integration**

The integration between Oracle’s CMRO and Enigma’s 3C provides a unique solution for maintenance service providers. This integration provides the maintenance technicians with a set of tools that connects Oracle CMRO’s extensive back office
functionality for configuration management, engineering, maintenance planning, and execution with Enigma's documentation centric maintenance execution system in a wireless environment. This combination of the two products supports the maintenance technicians in efficiently executing all their maintenance tasks, achieving highest level of quality by providing the right information in the right place at the right time in a most user-friendly form.

**Fleet Maintenance Program**

You can use the Fleet Maintenance Program module to create maintenance requirements for all planned and unplanned maintenance. You can associate work cards and maintenance documents with maintenance requirements and define effectivity by associating these maintenance requirements with a master configuration, unit configuration or a product classification. To forecast maintenance due dates, you can designate intervals and thresholds on maintenance requirements. The Affected Items Listing enables maintenance personnel to view all units affected by a maintenance requirement.

**Master Configuration**

Using the Master Configuration module, you can record the *as designed* configuration of the equipment that is maintained. This enables you to easily navigate through the hierarchy, specify which parts can be used in the assembly, and provide technicians with permissible part choices for each location. To enable technicians to easily access the information that they need, you can link documents to part positions and work cards. Master configurations can be used as templates for creating unit configurations.

**Unit Configuration**

You can use the Unit Configuration module to track the current *as operated* configuration of the equipment and to maintain the life cycle service history of the system and all the component parts, while considering the special conditions that affect service life measurements. To enable easy access to information, you can record the positions in the assembly where serialized parts are located and associate documents with them.

In the case of an aircraft accident, the unit configuration can be quarantined (frozen) to prevent changes to be made to the configuration that could affect the current state of the affected unit. Only the CMRO super user can request a quarantine to a unit configuration.

**Related Topics**

Configuration Access Control Management and Working with Unit Configurations, *Oracle Complex Maintenance, Repair, and Overhaul User’s Guide*
Product Classification

The Product Classification module enables you to classify units into various groups for maintenance activities and associate documentation and maintenance requirements to these product classifications. The maintenance plans are automatically updated when units move from one group into another.

Unit Maintenance Plan

The Unit Maintenance Plan module enables you to maintain utilization forecasts, determine the remaining service time of units, and calculate due dates for maintenance requirements. Material requirements associated with the forecasted maintenance requirements are planned through Oracle Demand Planning application.

Minimum Equipment List (MEL) and Configuration Deviation List (CDL) functionality identifies equipment, as opposed to structural items, that can be inoperative or missing on aircraft—but still enable the aircraft to maintain airworthiness. MEL/CDL instructions are added to the CMRO planning process, enabling you to defer non-routine requirements.

Visit Work Package

The Visit Work Package module enables you to create equipment-based maintenance visit definitions that connect equipment with a block of tasks, location and date. You can manage maintenance requirements, calculate costs incurred on a visit using the visit task work breakdown structure, and define job hierarchy for all tasks in a visit.

Long Term Planning

The Long Term Planning module enables you to assess the maintenance workload capacity for all facilities and define a maintenance visit’s resource requirements. You can schedule maintenance visits across the organization based on resource and facility availability, and compare resource capacities with resources required for the projected workload. Material requirements associated with the maintenance requirements in a visit are scheduled through Oracle’s Advanced Supply Chain Planning application.

The Serial Number Reservation feature enables the maintenance and material planners to reserve specific items for scheduled maintenance. Items may be selected based on defined material requirements and the condition and utilization history of the items.

Production

The Production module enables you to view job assignments, component and material availability; record maintenance activities, job completion, material and component consumption; and update maintenance compliance details. To satisfy regulatory requirements, quality inspection results can be issued. You can initiate new service
requests for unplanned maintenance discovered during planned maintenance visits. The Production module enables you to track all time and materials associated with jobs throughout the repair cycle and interfaced to Oracle Costing, to provide maintenance organizations with a real view into service costs.

**Production Planning**

The Production Planning module offers maintenance organizations an extensive site-level planning tool. Production planners managing shop floor activities assign personnel and equipment to jobs, fine tune work schedules, manage procurement and create material requirements for unplanned maintenance. Using Production planning, you can track components sent out for repair against the maintenance visit. Planners and shop floor managers consider working conditions when planning thereby ensuring a safe working environment.

**Outside Processing for Work Orders**

Using Outside Processing (OSP), you can ship serialized parts to independent service organizations for service. Production planners assign jobs to third-party providers and group jobs that are marked for outside servicing onto an OSP work order. The work order contains all the information required for executing the required service. When the OSP work order is finalized, purchase orders and shipping orders are created. After the work is completed, jobs are reassigned to internal personnel for quality checks and parts receiving.

**Outside Processing for Inventory Service Orders**

Using Outside Processing for Inventory service orders, you can create a service order directly from an inventory location without having to create a visit and an execution work order. The work order contains all the information required to reduce the time to create a service order and reduces the risk of errors. This feature increases the productivity of service order clerks, and improves the quality and accuracy of service order data.
Overview

This chapter discusses setting up Oracle Complex Maintenance, Repair and Overhaul (CMRO). It includes the following topics:

- Getting Started, page 2-1
- Oracle CMRO Implementation Checklist, page 2-2
- Setting Up Oracle CMRO, page 2-7
- Setting Up Other Related Oracle Applications, page 2-7
- CMRO Specific Setups, page 2-7

Getting Started

Before setting up CMRO, you must identify all your implementation users, and the access privileges that they require. You can create additional implementation responsibilities if you want to restrict access.

You must use the System Administrator responsibility to create the required Oracle Applications users. Implementation users need access to one or more of the following responsibilities:

- System Administrator
- AHL Super User
- Foundation Administrator
- Support Administrator
Use the Users window to define Oracle Applications users. An Oracle Application user is uniquely identified by an application user name.

For detailed instructions on creating application users, refer to Oracle E-Business Suite Setup Guide

Oracle E-Business Suite Maintenance Guide

Oracle E-Business Suite Security Guide

Oracle CMRO Implementation Checklist

This section contains a checklist that includes the steps that you must follow to implement Oracle CMRO. They include setup steps for data that is shared with other Oracle Applications, but is required by Oracle CMRO.

You must set up other related Oracle applications prior to setting up CMRO.

Setting Up an Organization, page 2-8

<table>
<thead>
<tr>
<th>Description</th>
<th>Reference</th>
</tr>
</thead>
<tbody>
<tr>
<td>Step 1 - Set Up an Operating Unit</td>
<td>Oracle Human Resources User’s Guide</td>
</tr>
<tr>
<td>Step 2 - Create an Organization</td>
<td></td>
</tr>
<tr>
<td>Step 3 - Set Up an Inventory Organization</td>
<td></td>
</tr>
</tbody>
</table>

Setting Up Oracle Inventory, page 2-25

<table>
<thead>
<tr>
<th>Description</th>
<th>Reference</th>
</tr>
</thead>
<tbody>
<tr>
<td>Step 1 - Set Up Master Items</td>
<td>Oracle Inventory User’s Guide</td>
</tr>
<tr>
<td>Step 2 - Set Up Subinventory</td>
<td></td>
</tr>
</tbody>
</table>

Setting Up Oracle Bills of Material (BOM), page 2-36

<table>
<thead>
<tr>
<th>Description</th>
<th>Reference</th>
</tr>
</thead>
<tbody>
<tr>
<td>Step 1 - Set Up Departments and Resources</td>
<td>Oracle Bills of Material User’s Guide</td>
</tr>
</tbody>
</table>
### Setting Up Oracle Warehouse Management, page 2-39

<table>
<thead>
<tr>
<th>Description</th>
<th>Reference</th>
</tr>
</thead>
<tbody>
<tr>
<td>Step 1 - Associate Departments with Subinventories</td>
<td>Oracle Warehouse Management User’s Guide</td>
</tr>
<tr>
<td>Step 2 - Set Up Material Status</td>
<td></td>
</tr>
<tr>
<td>Step 3 - Associate Material Status with Subinventories</td>
<td></td>
</tr>
<tr>
<td>Step 4 - Set up Profile Options</td>
<td></td>
</tr>
</tbody>
</table>

### Setting Up Oracle Purchasing, page 2-44

<table>
<thead>
<tr>
<th>Description</th>
<th>Reference</th>
</tr>
</thead>
<tbody>
<tr>
<td>Step 1 - Set Up Buyers</td>
<td>Oracle Purchasing User’s Guide</td>
</tr>
<tr>
<td>Step 2 - Set Up Approvals</td>
<td></td>
</tr>
<tr>
<td>Step 3 - Set Up Purchasing Options</td>
<td></td>
</tr>
<tr>
<td>Step 4 - Set Up Receiving Options</td>
<td></td>
</tr>
<tr>
<td>Step 5 - Set Up Financial Options</td>
<td></td>
</tr>
<tr>
<td>Step 6 - Set Up Open Accounting Periods</td>
<td></td>
</tr>
</tbody>
</table>

### Setting Up Oracle Advanced Planning and Scheduling, page 2-47

<table>
<thead>
<tr>
<th>Description</th>
<th>Reference</th>
</tr>
</thead>
<tbody>
<tr>
<td>Step 1 - Set up Oracle Advanced Supply Chain Planning</td>
<td>Oracle Advanced Planning Implementation and</td>
</tr>
<tr>
<td></td>
<td>User’s Guide</td>
</tr>
<tr>
<td>Step 2 - Set up Oracle Demand Planning</td>
<td>Oracle Demand Planning Implementation and User’s Guide</td>
</tr>
<tr>
<td>Step 3 - Set up Available to Promise</td>
<td>Oracle Global Order Promising Implementation and User’s Guide</td>
</tr>
</tbody>
</table>
Setting Up Oracle Order Management, page 2-49

<table>
<thead>
<tr>
<th>Description</th>
<th>Reference</th>
</tr>
</thead>
<tbody>
<tr>
<td>Step 1 - Set Up Security Processing Constraints</td>
<td>Oracle Order Management User’s Guide</td>
</tr>
<tr>
<td>Step 2 - Set Up Customers</td>
<td>Oracle Shipping Execution User’s Guide</td>
</tr>
</tbody>
</table>

Setting Up Oracle Projects, page 2-51

<table>
<thead>
<tr>
<th>Description</th>
<th>Reference</th>
</tr>
</thead>
<tbody>
<tr>
<td>Step 1 - Create a Project Template</td>
<td>Oracle Projects User’s Guide</td>
</tr>
<tr>
<td>Step 2 - Assign a Project Template Name to User Profile</td>
<td></td>
</tr>
</tbody>
</table>

Setting Up Oracle Enterprise Asset Management, page 2-53

<table>
<thead>
<tr>
<th>Description</th>
<th>Reference</th>
</tr>
</thead>
<tbody>
<tr>
<td>Step 1 - Set Up WIP Accounting Classes</td>
<td>Oracle Enterprise Asset Management User’s Guide</td>
</tr>
<tr>
<td>Step 2 - Set Up EAM Parameters</td>
<td></td>
</tr>
<tr>
<td>Step 3 - Set Up Asset Category Codes</td>
<td></td>
</tr>
<tr>
<td>Step 4 - Verify the WIP_EAM_Activity_Priority Lookup</td>
<td></td>
</tr>
</tbody>
</table>
### Setting Up Oracle Service, page 2-56

<table>
<thead>
<tr>
<th>Description</th>
<th>Reference</th>
</tr>
</thead>
<tbody>
<tr>
<td>Step 1 - Define Service Request Statuses</td>
<td><em>Oracle Customer Support Implementation Guide</em></td>
</tr>
<tr>
<td>Step 2 - Define Service Request Types</td>
<td></td>
</tr>
<tr>
<td>Step 3 - Define Service Request Severities</td>
<td></td>
</tr>
<tr>
<td>Step 4 - Set Up Profile Options</td>
<td></td>
</tr>
</tbody>
</table>

### Setting Up Oracle Contracts, page 2-62

<table>
<thead>
<tr>
<th>Description</th>
<th>Reference</th>
</tr>
</thead>
<tbody>
<tr>
<td>Step 1 - Set Up Buyers</td>
<td><em>Oracle Contracts Core Concepts and Procedures Guide</em></td>
</tr>
<tr>
<td>Step 2 - Set Up Suppliers</td>
<td></td>
</tr>
<tr>
<td>Step 3 - Set Up Standard Articles</td>
<td></td>
</tr>
<tr>
<td>Step 4 - Set Up Categories and Sources</td>
<td></td>
</tr>
<tr>
<td>Step 5 - Set Up Contract Groups</td>
<td></td>
</tr>
<tr>
<td>Step 6 - Set Up Contract Events</td>
<td></td>
</tr>
</tbody>
</table>

### Setting Up Oracle Installed Base, page 2-64

<table>
<thead>
<tr>
<th>Description</th>
<th>Reference</th>
</tr>
</thead>
<tbody>
<tr>
<td>Step 1 - Set Up Install Parameters</td>
<td><em>Oracle Installed Base Implementation Guide</em></td>
</tr>
<tr>
<td>Step 2 - Set Up Instance Statuses</td>
<td></td>
</tr>
<tr>
<td>Step 3 - Set Up Asset Locations</td>
<td></td>
</tr>
</tbody>
</table>
## Setting Up Oracle Counters, page 2-66

<table>
<thead>
<tr>
<th>Description</th>
<th>Reference</th>
</tr>
</thead>
<tbody>
<tr>
<td>Step 1 - Define Counter Groups</td>
<td><em>Oracle Service Implementation Guide</em></td>
</tr>
</tbody>
</table>

## Setting Up Oracle Quality, page 2-66

<table>
<thead>
<tr>
<th>Description</th>
<th>Reference</th>
</tr>
</thead>
<tbody>
<tr>
<td>Step 1 - Set Up Route and Operation Quality Plans</td>
<td><em>Oracle Quality User’s Guide</em></td>
</tr>
<tr>
<td>Step 2 - Set Up Deferral, MRB Disposition Quality, Non-Routine Job Inspection and Non-Routine Operation Inspection Plans</td>
<td><em>Oracle Quality User’s Guide</em></td>
</tr>
<tr>
<td>Step 3 - Create Counter Readings Quality Plan</td>
<td><em>Oracle Quality User’s Guide</em></td>
</tr>
</tbody>
</table>

## Oracle Complex Maintenance, Repair, and Overhaul Standard Setup, page 2-73

<table>
<thead>
<tr>
<th>Description</th>
<th>Reference</th>
</tr>
</thead>
<tbody>
<tr>
<td>Step 1 - Set Up Profile Options</td>
<td>-</td>
</tr>
</tbody>
</table>

## Oracle CMRO Approval Workflow Setup, page 2-77

<table>
<thead>
<tr>
<th>Description</th>
<th>Reference</th>
</tr>
</thead>
<tbody>
<tr>
<td>Step 1 - Set Up Profile Options</td>
<td>-</td>
</tr>
<tr>
<td>Step 2 - Create Approval User(s) and Role</td>
<td>-</td>
</tr>
</tbody>
</table>
Setting Up Oracle CMRO

This section includes the following topics:

- Setting Up Other Related Oracle Applications, page 2-7
- CMRO Specific Setups, page 2-7

Setting Up Other Related Oracle Applications

Oracle CMRO is integrated with other Oracle eBusiness suite applications. This integration lends additional functionality to Oracle CMRO and enables it to fully support the maintenance, repair and overhaul needs of operators, third-party maintenance, and original equipment manufacturers. You must first set up an organization and then install and implement the Oracle applications or components.

This section covers the following topics:

- Setting Up an Organization, page 2-8
- Setting Up Oracle Inventory, page 2-25
- Setting Up Oracle Bills of Material (BOM), page 2-36
Setting Up an Organization

In general, an organization can be a company, department, division, cost center, or virtually any other organizational unit within a business. The organizational setup includes these steps:

- Setting Up an Operating Unit, page 2-8
- Creating an Organization, page 2-8
- Setting Up an Inventory Organization, page 2-8

Setting Up an Operating Unit

An operating unit is the organization unit through which you create, process, report, and secure financial applications data.

To set up an operating unit, you must:

1. Develop an organization structure.
2. Define set of books.
3. Define locations.
4. Define business groups (optional).
5. Associate responsibilities with business group (optional).

6. Define organizations.

7. Define organization relationships.

8. Define responsibilities.

9. Set the MO: Operating unit profile option.

10. Convert to the Multiorg Architecture (required only if current set up is not multiorg enabled).


12. Set the profile options that are specific to the operating unit.

13. Define the Inventory organization security (optional).

14. Implement the application products.

**Creating an Organization**

**To create an organization:**

1. Select the Manufacturing and Distribution Manager responsibility. From the Navigator, select Inventory > Setup > Organizations > Organizations. The Find Organization window appears.

2. Click the New (A) button.

3. Enter an organization Name.

4. Select the following values from the Organization Classification list of values:
   - Business Group
   - HR Organization
   - GRE/Legal Entity
   - MRP Organization
   - Operating Unit
   - Project Expenditure
   - Project Manufacturing Organization
• Project Task Owning Organization

5. Select the Enable check box for all the Organization Classification parameters.
6. Save your work.

**Organization Classifications**

**Business Group:** The purpose of the business group is to partition human resource information. The business group is the highest level in an organization structure hierarchy in the E-Business Suite. You can use the business group to model the consolidated enterprise or a major division of a company that is an employer.

**HR Organization:** The HR Organization classification is applied to the organizations to which the user assigns employees.

**Government Reporting Entities (GRE):** The GRE in the Oracle Human Resources products is the same organization as the legal entity that appears in the Oracle Financials products. The GRE represents the real-world legal entity that pays employees, withholds their taxes, and provides reports on various matters to government agencies.

**Setting Up an Inventory Organization**
The Inventory Organization is an organization for which you track inventory transactions and balances.
To set up an Inventory Organization:

1. From the Navigator, select Inventory > Setup > Organizations > Organizations. The Find Organization window appears.

2. Click the New (A) button. The Organization window appears.

3. Enter an organization name in the Name field.

4. Within the Organization Classification block, select the following values from the Name list of values (LOV):
   - HR Organization
   - Inventory
   - MRP
   - Project Expenditure
   - Project Manufacturing Organization
   - Project Task Owning Organization
   - WIP Organization
5. Select the Enable check box for each of the organization classifications that you selected.

6. Save your work.

7. Now you will set up the parameters for each of the above mentioned organization classifications.

**To set up HR Organization parameters:**

1. In the Organizations window, select the HR Organization value. Click the Others button. The Additional Organization Information window appears.

2. Select Costing Information from the list. Enter a value in the Costing Information field.

3. Save your work.

4. Navigate to the Additional Organization Information window and select the Parent Organization value. Select Primary Reporting Hierarchy from the Hierarchy LOV.

5. From the Name LOV, select the organization that you have defined and enabled as a business group.

6. Save your work.
To set up Inventory Organization parameters:

1. Select Inventory Organization in the Organizations window. Click the Others button. Select the Accounting Information value from the list of values.

2. Click in the Accounting Information field. The Accounting Information descriptive flexfields window opens.

3. Select the Set of Books, Legal entity and Operating Unit values. Click OK.

4. Save your work.

Accounting Information

5. Navigate to the Additional Organization Information window and select Inventory Information. The Organization Parameters window opens.

6. Click the Inventory Parameters tab. Enter an organization code.

7. Select the Item Master Organization and Calendar values.

8. Select the EAM Enabled check box.
9. Save your work.

**Organization Parameters - Inventory Parameters**

<table>
<thead>
<tr>
<th>Field</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Lot Control Uniqueness</td>
<td>None</td>
</tr>
<tr>
<td>Lot Control Generation</td>
<td>At Organization Level</td>
</tr>
<tr>
<td>Serial Control Uniqueness</td>
<td>Within Inventory Items</td>
</tr>
<tr>
<td>Serial Control Generation</td>
<td>At Item Level</td>
</tr>
</tbody>
</table>
11. Save your work.

12. Click the Costing Information tab. Select the Costing Method that is applicable to your organization.

13. Select the Enable Project Cost Collection check box.

14. Enter the required information in the Valuable Accounts block.
15. Save your work.

16. Click the ATP, Pick, Item-Sourcing parameters tab. Select an ATP Defaults Rule from the Rule LOV.
17. Save your work.

**To set up MRP Organization parameters:**

1. In the Organization window, select the MRP Organization.
2. Click the **Others** button.
   The Planning Parameters window opens.
3. Select the Net WIP and Net Reservations check boxes.
4. Save your work.

**To set up Work in Process (WIP) Organization parameters:**

1. Select the WIP Organization value in the Organization window.

2. Click the **Others** button, and click the Backflush Defaults tab.

3. Select Supply subinventory from the LOV.

   Enter a Supply Locator (if required).
4. Click the Move Transaction tab. Select the Allow Creation of New Operations and the Allow Moves Over No Move Shop Floor Statuses check boxes.
5. Click the Intraoperation tab. Enable the Queue check box. Clear the other check boxes.
6. Save your work.

7. From the Navigator, select WIP > Setup > WIP Accounting Class.

8. Enter a value in the Class and Description fields.

9. Select Standard Discrete from the Type drop-down list. Enter Accounts information.
10. Save your work.

11. You must also create Expense Non-Standard, Maintenance, and Asset Non-Standard Accounting Classes. For more information about setting up accounting classes, see the Oracle Work in Process User’s Guide.

12. Save your work.

13. From the Navigator, select Inventory > Setup > Organizations > Organizations. Query for your organization.

14. Select the WIP Organization value within the Organization Classifications block. Click the Others button. The Work in Process parameters window appears.

15. Click the Discrete tab. Select a default value from the Discrete Class drop-down list.

16. Save your work.

To set up Project Manufacturing parameters:

1. In the Organizations window, select the Project Manufacturing Organization value.

2. Click the Others button.
The Project Manufacturing Parameters window opens.

3. Click the General tab.

4. Select the Enable Project Reference check box.

5. Select Task from the Project Control Level drop-down list.

6. Click the Invoice Transfer tab.
   Select the IPV check box to enable IPV.

7. Select Material from the Expenditure Type LOV.

8. Save your work.

To set up Project Task Owning Organization parameters:

1. In the Organizations window, select the Project Task Owning Organization value. Click the Others button, and the Additional Organization Information window opens.

2. Click in the Project Type Class Information field. In the Project Type Class Information window, select Yes for all the following parameters:
• Allow Entry of Indirect Projects
• Allow Entry of Capital Projects
• Allow Entry of Contract Projects

**Project Type Class Information**

![Project Type Class Information](image)

1. Click OK. Save your work.

**To set up Project Expenditure/Event Organization parameters:**

1. In the Organizations window, select the Project Expenditure/Event Organization value. Click the Others button.
2. Click in the Exp Org Defaults field. The Exp Org Defaults sub-window appears.
3. Enter or select an operating unit (the same as the item master organization).
4. Save your work.

**Additional Setup**

1. From the Navigator, select Inventory, Accounting Close Cycle, Inventory Accounting Periods.
2. Select an Inventory Accounting Period value, and change the status to Open.
3. Save your work.
Setting Up Oracle Inventory

In Oracle CMRO, you use instances of Oracle Inventory when defining the allowable parts in a master configuration, and when describing the components in a unit configuration. Oracle CMRO invokes Oracle Inventory methods to populate the database with information on allowable components in a configuration, and the components actually available to create a unit configuration. The Production module uses predefined inventory items as references when invoking the inventory methods that issue and return parts, or when defining the material requirements for an organization job. The Route Management module uses the predefined inventory items as material and tool requirements used to perform a route or an operation.

Setting up Oracle Inventory includes the following steps:

- Creating component items.
- Creating service items.
- Setting up Subinventories.

You must define items and set up at least one subinventory for each Inventory organization.

Creating Component Items

1. Select the Manufacturing and Distribution Manager responsibility. From the Navigator, select Inventory > Items > Master Items.
Note: All items must be set up at the Master Inventory Organization level and then assigned to specific Inventory Organizations. Oracle recommends that you define an item template for each type of item that will be used in your organization.

2. Enter a name in the Item field.

3. Enter a description.

4. Click the Main tab. The default value for the Item Status field is Active, however, you can select a different status from the drop-down menu.

5. Click the Inventory tab. Select the following check boxes:
   - Inventory Item
   - Stockable
   - Reservable
   - Transactable

6. Select the No Control option in the Lot Expiration and Lot regions.
7. Select the Serial Control: At Receipt option in the Serial Generation field if items are serial number trackable. If they are not, then select the Non-Serialized option.

8. Select the No Control option from the Locator Control drop-down menu.

9. Click the Bills of Material tab. Select the BOM Allowed check box.

10. Click the Asset Management tab. Select the Rebuildable option from the Asset Item Type drop-down menu.

   **Note:** You can select a value in the Asset Item Type field only if the Oracle Enterprise Asset Management (eAM) setup is complete. Set up at least one item with an asset group of Rebuildable in eAM.

11. Click the Costing tab. Select the following check boxes:

     - Costing Enabled

     - Inventory Asset Value

     - Include in Rollup

12. Enter a value in the Cost of Goods Sold Account field.
13. Click the Purchasing tab. Select the following check boxes:
   - Purchased
   - Purchasable
   - Allow Description Update

14. In the Invoice Matching group box, select No in the Receipt Required field.
15. Click the Physical Attributes tab.

**Note:** When you enter values for the Weight, Volume, and Dimensions fields, you must select the Container check box to ensure that the shipment flow works properly.

16. Click the General Planning tab.

Select the Min-Max option from the Inventory Planning Method drop-down list.

17. Click the MSP/MRP Planning tab.

- Select the MRP Planning option from the Planning Method drop-down menu.
- Select the Hard Pegging option from the Pegging drop-down list.
18. Click the Order Management tab. Select the following check boxes:

- Customer Ordered
- Internal Ordered
- Customer Orders Enabled
- Internal Orders Enabled
- Shippable
- The Check ATP attribute should be set to **Material Only** and the applicable ATP rule should be defined
- OE Transactable
• Returnable

**Master Item - Order Management**

19. Click the Work in Process tab.
   - Select the Build in WIP check box.
   - Select the Push option from the Supply Type drop-down list.

20. Click the Invoicing tab.
    Select the Invoiceable Item and Invoice Enabled check boxes.
21. Click the Service tab.
Select the Track in Installed Base check box.

22. Save your work.

Setting Up Service items

Use the Master Item page to set up service items.

1. Set up a new service item with attributes as follows:

<table>
<thead>
<tr>
<th>Attribute</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Item Status</td>
<td>Active</td>
</tr>
<tr>
<td>Inventory Item</td>
<td>Disabled</td>
</tr>
<tr>
<td>Stockable</td>
<td>Disabled</td>
</tr>
<tr>
<td>Reservable</td>
<td>Disabled</td>
</tr>
<tr>
<td>Purchased</td>
<td>Selected</td>
</tr>
<tr>
<td>Purchasable</td>
<td>Selected</td>
</tr>
<tr>
<td>Allow Description Update</td>
<td>Selected</td>
</tr>
</tbody>
</table>
### Master Item - Purchasing (Service Item Setup)

- **Organization Item**: AC1000
- **Description**: Aircraft Service Item
- **Display Attributes**: Master, Org, All
- **Purchasing**: Invoice Matching
  - Receipt Required: Yes
  - Inspection Required: No
- **Unit Type**: -
- **Invoice Close Tolerance**: %
- **Invoice Close Tolerance**: %
- **Encumbrance Account**: 01-510-7530-0000-000
- **Expense Account**: 01-510-7530-9900-000
- **Asset Category**: -
- **Unit of Issue**: -
- **Default Buyer**: -
- **Receipt Close Tolerance**: %
- **List Price**: -
- **Price Tolerance**: %

---

2. Save your work.

### Setting Up a Subinventory:

1. Select Inventory > Setup > Organizations > Subinventories.
   
   The Subinventories window appears.

2. Define the Stores, MRB, and Consumable subinventories.

   **Note**: Cost group and locators must be set up before defining subinventories.

3. Stores in the Name field to define the Stores subinventory.

4. Select Active from the Status list of values.
5. Select the following check boxes:
   
   - Quantity Tracked
   - Asset Subinventory

   **Note:** The Include in ATP, Allow Reservations, and Nettable default values are selected and cannot be changed. These values are defined on the Material status Definition page (Inventory > Setup > Material Status). See the *Oracle Inventory User’s Guide* for more information.

**Subinventories**

6. Click the Accounts tab and enter the appropriate accounting values.
7. Save your work.

8. Click the New icon to create a new subinventory.
   1. Enter MRB in the Name field.
      
      **Note:** The status must be set to MRB Review. You must install Oracle Warehouse Management (WMS) to use this status. You can set the status to Active initially, install Warehouse Management, create additional Transaction Types in WMS and then change subinventory status to 'MRB Review'.

   2. Select Active from the Status list of values.

9. Select the following check boxes:
   - Quantity Tracked
   - Asset Subinventory

10. Click the Accounts tab and enter the appropriate values.

11. Save your work.

12. Click the New icon to create a new subinventory.
    1. Enter Consumable in the Name field.
    2. Select Active from the Status list of values.
13. Select the Quantity Tracked check box.

14. Clear all other attributes.

15. Click the Accounts tab and enter the appropriate accounting values.

16. Save your work.

17. Click the New button to define a new subinventory.
   1. Enter Scrap in the Name field.
   2. Select the Unserviceable option form the Status list of values.
   3. Select the Quantity Tracked check box.
   4. Clear all other attributes.

18. Click the Accounts tab and enter the appropriate accounting values.

19. Save your work.

For more information regarding subinventories, see *Oracle Inventory User’s Guide*.

**Setting Up Oracle Bills of Material (BOM)**

Oracle CMRO uses the resources and departments that are set up in Oracle Bills of Material as the basis for the production job resource requirements.

Before setting up Oracle Bills of Material, you must ensure that:

- Calendars and Exception templates are set up.
- Employees have been set up.

Setting up Oracle Bills of Material includes setting up departments and resources.

**To Set Up Departments and Resources:**

1. Select the Manufacturing and Distribution Manager responsibility.
   
   From the Navigator, select Bills of Material > Setup > Department Classes.

2. Set up department classes.
   
   For Outside Processing purposes, you must set up at least one department class called Vendor.
3. To set up a department, navigate to Bills of Material > Routings > Department, and the Departments window appears.

4. Set up at least one department that will be associated with the department class Vendor (case sensitive). It is recommended that you set up a department that the users can easily identify as an outside department, for example, Outside Service (OSV).
Departments

5. Associate all the departments with a location.

6. Set up Resources and associate with Employees. To set up resources navigate to Routings > Resources.

7. Define a resource type of Machine.
Note: In the item master, you must select the Equipment option (Physical attributes) to see valid values.

8. Set up standard operations.

9. Save your work.

Note: You must set up departments and resources at the operating unit, as well as at the Inventory Organization level. Routes are set up at the operating unit level. Visits (Visit Work Package - CMRO) are set at the Inventory Organization level.

See Also:
Oracle Bills of Material User’s Guide

Setting Up Oracle Warehouse Management

Oracle Warehouse Management provides maintenance organizations the functionality to control their inventory by status or condition and associate subinventories with a department. Before setting up Oracle Warehouse Management, you must ensure that:
• Oracle Inventory setup is complete.

• Supply subinventories are setup.

• Departments have been set up in Oracle BOM.

Setting up Oracle Warehouse Management includes:

• Associating departments with subinventories.

• Defining material status.

• Associating material status with subinventories.

• Setting up profile options.

To associate departments with subinventories:

1. Change the responsibility to Warehouse Management Super User.
   
   From the Navigator, select Setup > Warehouse Configuration > Resources > Associate Departments & Subinventories. The Department Subinventories window appears.

2. Select a value from the Department list of values and associate it with a subinventory.

3. Save your work.
To set up Material Status:

1. Navigate to Setup > Transaction Setup > Inventory Transactions > Material Status. The Material Status Definition window appears.

2. Set up the following statuses:
   - MRB
   - Unserviceable
   - Serviceable
3. Save your work.

To associate Material Status with Subinventories:

1. Navigate to Setup > Warehouse Configuration > Warehouses > Subinventories. The Subinventories Summary window appears.

2. Select a subinventory and associate a material status with it.
To set up Profile Options:

1. Change the responsibility to Application Developer. Navigate to Other > Profile. The Personal Profile Values window appears.

2. Set up profile options as indicated in the table below.

<table>
<thead>
<tr>
<th>Profile Name</th>
<th>User Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>AHL: Material Status - Serviceable</td>
<td>Serviceable</td>
</tr>
<tr>
<td>AHL: Material Status - Unserviceable</td>
<td>Un-Serviceable</td>
</tr>
<tr>
<td>AHL: Material Status - MRB</td>
<td>MRB</td>
</tr>
</tbody>
</table>
3. Save your work.

See Also:

Oracle Warehouse Management User’s Guide

Setting Up Oracle Purchasing

Before setting up Oracle Purchasing, you must ensure that:

- Oracle Inventory setup is complete.
- Supply subinventories have been set up.
- Oracle Human Resources setup is complete.

To set up Oracle Purchasing:

1. Change the responsibility to Manufacturing and Distribution Manager. From the Navigator, select Purchasing.

2. Set up the following in Oracle Purchasing:
   - Approvals
   - Buyers
• Purchasing Options
• Receiving Options
• Financial Options
• Open Accounting Periods

**Approval Groups Window**

![Approval Groups Window](Image)
3. Save your work.

See Also:

Oracle Purchasing User’s Guide
Setting Up Oracle Advanced Planning and Scheduling

Oracle CMRO integrates with Oracle's Advanced Planning and Scheduling (APS) applications for supply chain management. Advanced Supply Chain Planning (ASCP), is used to schedule required materials from maintenance visits. Available to Promise (ATP) is used for material availability inquiries, as well as scheduling through ASCP. Demand Planning (DP) is used for creating material demand from three sources: global demand from forecasted requirements in Unit Maintenance Plan; scheduled demand from requirements scheduled to maintenance visits; and historical non-routine (and routine) demand from maintenance accomplished at specific faculties. Additionally, Oracle APS's Inventory Optimization (IO) application is required for complete supply chain planning.

The following sections discuss the required setup:

Advanced Supply Chain Planning

- The APS applications employ a component architecture in which transaction processing and planning can occur in separate database instances. The correct instances to collect and query from must be defined. Collections from ASCP, DP, and ATP queries from the CMRO instance must be directed to the correct instance. For information, refer to the Oracle Advanced Planning Implementation and User’s Guide.

- The user must create an ASCP plan to process the collected material requirements. The applicable organizations, demand and supply schedules must be defined. Additionally, the Include Sales Orders check box must be selected in the Plan Options window. For information on defining plans, refer to the Oracle Advanced Planning Implementation and User’s Guide.
Demand Planning

- Demand planning collections must be set up. For information on setting up data collections, refer to the *Oracle Demand Planning Implementation and User Guide*.

- The correct application instance must be defined and the applicable organizations for that instance must be enabled. All organizations that have CMRO material requirements must be checked.
**Application Instances**

- Users must define a demand plan. To capture the data collected from CMRO, the plan must include the following input parameters:
  
  **Material Requirements** - Scheduled Visits (collections for all requirements in a maintenance visit)

  **Material Requirements** - Planned Maintenance (collections for all forecasted requirements in the Unit Maintenance Plan)

  **Material Usage History** - Unplanned Maintenance (collections for all non-routine requirements created during the production process, per organization)

  **Material Usage History** - Planned Maintenance (an optional stream for all historical planned requirements, essentially collections for the Unit Maintenance Plan's history)

For information on creating demand plans, refer to the *Oracle Demand Planning Implementation and User Guide*.

**Available to Promise**

The source and destination instance must be defined. For information, refer to the *Oracle Global Order Promising Implementation and User’s Guide*.

**Setting Up Oracle Order Management**

Before setting up Oracle Order Management (OM), you must ensure that:
• Oracle Inventory setup is complete.
• Supply subinventories have been set up.
• Oracle Purchasing setup is complete.

Setting up Oracle Order management includes:
• Setting up processing constraints.
• Creating customers.

To set up processing constraints:
1. From the Manufacturing and Distribution Manager responsibility, navigate to Order Management > Set Up > Rules > Security > Processing Constraints. The Processing Constraints window appears.

2. Click the Find button to search for the Order Sales Credit entity.

3. In the Constraints field, clear the Create, Update, Delete, and Cancel Operations options.

4. Click the Applicable To tab. Select the Authorized Responsibilities Radio Button and provide a list of Responsibilities that can perform the above listed actions.

5. Save your work.

6. Query for the Order Line entity.

7. Select the Create, Update, Delete, and Cancel operations for the same.

8. Click the Applicable To tab. Click the Authorized Responsibilities radio button and provide a list of responsibilities that can perform the selected actions. Save your work.

   **Note:** Setting up processing constraints ensures that Order Management users are not able to update any sales orders created within CMRO.

To define Customers:
1. Navigate to Customers > Standard. The Find/Enter Customers window opens.

2. Define your customers.
Note: For outside order processing, you must set up customers in Order Management identical to the suppliers that you created in Oracle Purchasing. You must do this step for only those suppliers to whom you will be shipping out the parts for service. Oracle recommends that you create customer names to be exactly the same as your supplier name.

See Also:

*Oracle Order Management User’s Guide*

**Setting Up Oracle Projects**

CMRO uses Oracle Projects as part of its maintenance planning and production flows. A project is created for each visit work package and project tasks are created for each visit work package. The project tasks are used in the maintenance planning flow to allow the required materials to be pegged to the corresponding visit tasks through Oracle’s MRP application. A visit’s corresponding project is used in the maintenance execution flow to collect costs associated to resource and material transactions performed in CMRO’s Production module. Use the standard billing functionality in Oracle Project Manufacturing to generate the required reports for the corresponding visit work packages.

Setting up Oracle Projects includes the following steps:

- Defining Service Types.
- Creating a Project Template.
- Assigning the Project Template name to an user profile.

**To define service types:**

1. Navigate to the Service Type Lookups page (Projects > Setup > Service Types).
2. Define the service types to be used in Oracle CMRO.
3. Save your work.

For more information about defining service types, refer to the *Oracle Projects Implementation Guide*.

**To create a project template:**

1. Navigate to the Projects Super User responsibility. From the Navigator, select Setup > Projects > Project Templates.
2. Click the Create Template button.

3. Enter the required information.

   **Note:** You must enter values in all required fields or the project templates cannot be approved.

4. Save the project template.

   **Note:** This template should be created for the applicable inventory master organization. All projects created for the maintenance visits use this project template.

5. The project status changes to Submitted. For more information about the creation of project templates and the manner in which you use them to create projects and submit for approval, refer to the *Oracle Projects User’s Guide*.

### To assign the project template name to an user profile:

1. Navigate to the System Administrator responsibility. From the Navigator, select Profile > System. The Find System Profile Values window appears.

2. In the Profile field, search for the AHL: Default Project Template ID value. Click the Find button.

3. Select the project template that you created from the Site LOV.

4. Save your work.

   **Note:** You can change most of your user profile options; values that you enter in the User Value field override the values preset by the System Administrator. Some profile options cannot be changed, but are displayed for informational purposes only. To change the user profile options, access the Application Developer responsibility and navigate to Other > Profile.. Enter the required values in the Personal Profile Values window.

For more information on System profile options and the procedures for setting them up, refer to the *Oracle E-Business Suite Setup Guide*.

### Verifying and Updating the Project Created in the CMRO Visit Work Package

The maintenance planner must manually define the project parameters for the project created in the CMRO Visit Work Package.
To verify and update the project created in the CMRO Visit Work Package:

1. Navigate to the Manufacturing and Distribution Manager responsibility. Select Bills of Material > Project > Project Definitions > Project Parameters. The Project Parameters window appears.

2. Enter the Visit Number in the Project Number field to search for the project created in Visit Work Package.

3. Verify the Organization name. It should be the same as the Visit Work Package organization.

4. Optionally, change the Cost Group.

5. Optionally, change the Default WIP class.

6. Click the Invoice Transfer tab. Optionally, change the IPV.

7. Make other changes if required.

Related Topics

Oracle Projects User Guide

Setting Up Oracle Enterprise Asset Management

Oracle CMRO uses the same work order system as Oracle Enterprise Asset Management (eAM). It also uses the Oracle eAM functionality to complete operations. Oracle CMRO benefits from Oracle eAM's enhanced integration with Oracle Costing.

Before setting up Oracle eAM, you must ensure that:

- Oracle Inventory setup is complete.
- Oracle WIP setup is complete.
- Oracle BOM setup is complete.
- Oracle Purchasing setup is complete.

To set up Oracle Enterprise Asset Management:

1. Navigate to the Enterprise Asset Management responsibility.

2. Navigate to Setup > WIP > WIP Accounting Classes. Set up the following WIP accounting classes:
   - Standard
• Expense
• Maintenance
• Asset Non-Standard

**WIP Accounting Classes Window**

3. Set up the eAM parameters.
4. Set up a category code for the Asset Management structure. Navigate to Setup > Category > Category Codes. Search for the Asset Management structure name. For more information on setting up category codes, see the Oracle Enterprise Asset Management User’s Guide.


6. Query for Enterprise Asset Management in the Name field. Select the category code that you created from the Default Category list of values.
7. Save your work.

8. Navigate to Setup > Lookup. The Oracle Manufacturing Lookups window appears. Query for WIP_EAM_ACTIVITY_PRIORITY lookup in the Type field. Verify that the following values are set up:

<table>
<thead>
<tr>
<th>Code</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>High</td>
</tr>
<tr>
<td>2</td>
<td>Medium</td>
</tr>
<tr>
<td>3</td>
<td>Low</td>
</tr>
</tbody>
</table>

---

Oracle Manufacturing Lookups Window

See Also:

Oracle Enterprise Asset Management User Guide

Setting Up Oracle Service

Oracle Service provides Oracle CMRO with the functionality to create and update service requirements in a maintenance organization. The association of a service request to a visit task and production job enables the maintenance organization to track the service difficulty (non-routine) to the associated progress or resolution performed by
the maintenance personnel.

Setting up Oracle Service includes:

• Verifying and defining service request types, statuses, and their severity.
• Setting up the profile options.

To verify and define Service Request Type, Status, and Severities:

1. Define a request status. Access the Customer Support responsibility, and then select Setup > Definitions > Service Request Statuses. The Service Request Statuses window appears.

2. You can define the following statuses:
   • New
   • Open
   • Working
   • Assigned
   • Closed
Service Request Statuses

3. Define a request type. Navigate to Setup > Definitions > Service Request Types. The Service Request Type page appears.

   **Note:** You define service request types to categorize your service requests. For each service request type, you can set up related service request statuses that correspond with each service request type.

4. You can define the following request types:
   - Pilot Log
   - Cabin Log
   - Mechanic Log
   - Inspection Log
   - Technical Problem

6. Select the Complex Maintenance check box.

7. Verify that the following request severities are defined:
   - High
   - Low
   - Medium
Select values in the Type, Status, and Severity fields, if they are different than the default values. Default values in these fields come from the profiles setup. For more information on profiles, see Setting Up Oracle Support Profiles in the Oracle Support Implementation Guide.

You can override these defaults if necessary by changing the appropriate profile options. For more information, see Setting Up Support Related Profile Options in the Oracle Support Implementation Guide.

To set up the profile options:

1. Navigate to the System Administrator responsibility, and then select Profile > System. The Find System Profile Values window appears.

2. Search for the AHL: Default SR Customer Name value in the Customer Name field. Click the Find button.

3. Save your work.

4. Find System profile value - AHL: Default SR Severity. Select the default Severity Value from the Site LOV.


6. Find System profile value - AHL: Default SR Type. Select the default SR Type.

7. Save your work.
Setting Up Objects for Disposition

Maintenance or inspection personnel use the disposition details defined in the Route Management module to transact the material (serviceable/non-serviceable) and initiate overhaul, repair or scrap requirements accordingly. The JTF object for disposition is seeded as belonging to the Oracle Service application. After installation, you must create a relationship between a disposition and an object type of Service Request.

**To create a relationship between a Disposition and the Service Request object type:**


2. Click the Update icon button for the Refers to relationship. The Valid Objects: Refers to Relationships page appears.

3. Click Add Another Row. Add a new relationship as Service Request (Object Type) – Refers to (Relationship) - Production Disposition (Related Object Type).

4. Save the record.
Valid Objects: Refers to Relationships

Setting Up Oracle Contracts

CMRO's Outside Processing module uses the functionality supporting the Loan and Borrow Transaction in Oracle Contracts.

Before you set up Oracle Contracts, you must ensure that:

- Oracle Inventory setup is complete.
- Oracle Receivables setup is complete.
- Oracle Order Management setup is complete.
- Oracle Purchasing setup is complete

Setting up Oracle Contracts includes:

- Setting up buyers.
- Setting up suppliers.
- Other setups.

To set up buyers:

1. From the Navigator, select Contract Manager > Setup > Others > Buyer > Buyer. The Find Buyer window appears.
2. Click the New Buyer button.
3. Select a Buyer Name from the list of values.
4. Enter other required data.
5. Save your work.

    **Note:** The buyers setup in Oracle Contracts will be displayed in the CMRO Select Buyer Name list for the user to select as the OSP Buyer.

**To set up suppliers:**

1. Navigate to Contract Manager > Setup > Others > Supplier > Entry. The Suppliers window appears.

2. Enter required information.

**Suppliers Window**

![Suppliers Window](image)

    **Note:** These setup suppliers will be available in CMRO OSP Vendor Name list.

**Other setups:**


2. Set up the standard articles, categories, and sources.

3. Optionally, set up the customers.

4. Set up the contract groups and contract events.

    **Note:** To find the approver of the contracts, you must look at the profile value: OKC: Contract Approver.
See Also:

*Oracle Contracts Core Concepts and Procedure Guide*

**Setting Up Oracle Installed Base**

After you define the master configuration, a framework exists that describes the general characteristics of the system, including the engineering rules for assembly. The user can then create a unit configuration. Oracle CMRO uses the methods in Oracle Installed Base to populate the database with transactions representing the as operated configuration of the system.

Before you set up Oracle Installed Base, ensure that these setups are complete:

- Oracle Inventory.
- Oracle Counters setup.
- Supplier and supplier sites (Purchasing).
- Customer and customer sites (Receivables).

**To set up Oracle Installed Base:**

1. Change responsibility to Oracle Installed Base Administrator. Navigate to Setups > Install Parameters.

2. Set up the Installed Base parameters.
3. Set up the instance statuses.

### Instance Statuses

<table>
<thead>
<tr>
<th>Status</th>
<th>Terminated</th>
<th>Status Change Allowed</th>
<th>Service Allowed</th>
<th>Requests Allowed</th>
<th>Updatable</th>
<th>Del</th>
<th>Status Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Active</td>
<td></td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Billing Failed</td>
<td></td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Billing Requested</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Billing Succeeded</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td></td>
<td></td>
</tr>
<tr>
<td>CREATED</td>
<td></td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Complete</td>
<td></td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

4. Optionally, set up the Maintain Locations values.

5. Set up the asset locations.

See Also:

*Oracle Installed Base Implementation Guide*
Setting Up Oracle Counters

To set up Oracle Counters:

1. From the Navigator, select Field Service Manager > Field Service Set Up > Counters > Define Counters.

2. Click the New button to define counters.

3. Set up the counter groups.

4. Associate the counter groups with the Oracle Installed Base items.

5. Optionally, associate the counter groups with maintain locations.

See Also:
Oracle Service Implementation Guide

Setting Up Oracle Quality

Oracle CMRO uses the setup from Route Management and the system profile options in Oracle Quality to enable maintenance organizations to capture quality elements for operations, jobs, deferrals, scrap management, and counter value snapshots. This gives maintenance facility the flexible integration required to maintain reliable products.

Oracle CMRO provides seeded plan templates for routes, operations, job deferrals, MRB dispositions and counter reading capturing. These templates can be used as-is or adjusted with additional quality elements. However, the counter reading template is used by CMRO in the background, and cannot be changed.

Setting up Oracle Quality includes:

- Setting up route and operation quality plans.
- Setting up Job Deferral, MRB Disposition Quality, Non-Routine Job Inspection and Non-Routine Operation Inspection Plans.
- Setting up Counter Readings Quality Plans.

Setting Up Route and Operation Quality Plans

Creating Inspection Types

You can create the different inspection types for route and operation quality recording. The inspection types are maintained in a seeded collection element known as an Inspection Type. Creating collection elements, collection element types and collection plan types have no specific CMRO setup requirements.
To create Inspection Types:

1. Change responsibility to Manufacturing and Distribution Manager. From the Navigator, select Quality > Setup > Collection Elements.

2. Select the organization for which you want to create a quality plan. The Collection Elements page appears.

3. Click the Inspection Type field and search for the Collection Element value.

4. Click the Values button.

5. Define the inspection types.

Note: The defined inspection types are the values that appear in the list of values for the quality inspection type attribute in routes and operations.

Creating Quality Plans

CMRO provides plan templates with seeded quality elements. Oracle recommends that you use these templates and adjust them for the specific needs rather than creating a new plan, because the template contains collection elements that are automatically populated by CMRO when quality is recorded in production. Should these elements be missing, the procedure would still work, but these attributes would not be recorded.
The background attributes contain information about the job, maintenance requirement, item and item instance and so on, which provides convenient quality reporting and analysis. The templates also contain seeded displayed items that are either mandatory or optional, and those properties can be changed. This approach enables the user to take full advantage of CMRO’s out-of-the-box quality functionality together with the flexibility to create completely customized quality plans. Creating and using plan types have no specific CMRO setup requirements.

To create Quality Plans:

2. Select the plan type.
3. Click the Copy Elements button. The Copy From Plan window appears.
4. Select the Plan template from which you want to copy. Select one of these options:
   - Advanced Service Online Operation Completion Plan
   - Advanced Service Online Route Completion Plan
5. Click the Transactions button. The Collection Transaction window appears.

6. Select the seeded transaction for route or operation. Select one of these options:
   - Maintenance Route Completion (Advanced Service Online)
   - Maintenance Operation Completion (Advanced Service Online)

7. Define the trigger. Select Inspection Type from the Trigger name list of values. The trigger value is selected from the setup in the Inspection Type collection element.

8. Save your work.
Collection Transactions

Note: The Inspection Types created can be associated with a route or operation in route management. When the route or operation is going to be instantiated in production, the user will have the derived quality plan available for collecting the quality results.

Setting Up Job Deferral, MRB Disposition Quality, Non-Routine Job Inspection and Non-Routine Operation Inspection Plans

Creating Inspection types

An inspection type for a deferral, MRP, non-routine job, and non-routine operation is defined in a system profile option. The inspection type will derive the existing plan in the organization where a job is deferred and an MRB disposition is initiated and a non-routine job or operation is created. You can create the different inspection types for job deferral, MRB disposition, and non-routine quality recording.

To create Inspection Types:

1. Navigate to the Collection Elements window. Click in the Collection Element field, and select the Inspection Type value.

2. Click the Values button. Define the inspection types for job deferral, MRB disposition, and non-routine quality recording.

Note: The defined inspection types appear in the list of values for the system profile option for job deferral and MRB disposition.
To create Quality Plans:

1. Navigate to the Collection Plans window.

2. Define collection plans for job deferral, MRB disposition and non-routine job or operation using the following plan templates:
   - Advanced Service Online MRB Disposition Plan
   - Advanced Service Online Route Completion Plan
   - Advanced Service Online Operation Completion Plan
   - Advanced Service Online Job Deferral Plan

3. Add or change quality elements if necessary.

4. Click the Transactions button. Select the following seeded transaction descriptions for job deferral, MRB disposition and non-routine job or operation:
   - Maintenance Job Deferral (Advanced Service Online)
   - MRB Disposition (Advanced Service Online)
   - Maintenance Route Completion (Advanced Service Online)
   - Maintenance Operation Completion (Advanced Service Online)

5. Define the trigger. Select Inspection Type from the Trigger drop-down list. The trigger value is selected from the setup in the Inspection Type collection element.

6. Save your work.

System Profile Options Setup

Set up the following options for a job deferral, MRB disposition and non-routine job or operation quality definition:

- AHL: Job Deferral Inspection Type
- AHL: MRB Disposition Inspection Type
- AHL: Non-routine Job Inspection Type
- AHL: Non-routine Operation Inspection Type

Setting Up Counter Readings Quality Plans

Whenever a maintenance requirement is completed in production, CMRO stores the
current counter values of the maintained item instance in a Counter Reading Quality Plan. The plan will adjust itself based on the counters defined on the item instance. This procedure is completely transparent to the user. The user must create a Counter Reading Quality Plan in Quality and set up the system profile option to enable counter reading capturing.

Creating Quality Plans

The Counter Readings Quality Plan is created using the template and cannot be adjusted, because the user has no influence over the recording of the counter values.

**Note:** You need to create only one counter reading plan because the same counter reading plan is used across all organizations.

To create Quality Plans:

1. Navigate to the Collection Plans window.
2. Select a value in the Plan Type field.
3. Click the Copy Elements button. Select the Advanced Service Online Counter Readings Plan template.
   
   **Note:** Do not adjust collection elements.

4. Do not define any transactions.

System Profile Options Setup

For the Counter Reading Quality Plan definition, set up the System Profile Option -AHL: Counter Reading Plan.

See Also:

*Oracle Quality User’s Guide*

**CMRO Specific Setups**

Oracle CMRO is an integrated, web-enabled software application suite designed to empower complex equipment maintenance organizations. Oracle CMRO supports maintenance processes such as scheduled and unscheduled maintenance visits, component monitoring, job scheduling and routing, labor time collection, cost collection, inventory management, and maintenance document management. CMRO provides models for electromechanical systems and defines rules for assembling units. CMRO also records unit-specific information, enabling quick access to the maintenance history of a product component.
Oracle CMRO is organized as follows:

1. Engineering
   - Fleet Maintenance Program (maintenance requirements)
   - Route Management (work card authoring)
   - Document Index (technical document management)

2. Configuration Management
   - Master Configuration (allowable installations)
   - Unit Configuration (as installed maintenance tracking)
   - Product Classification (logical grouping)

3. Planning
   - Unit Maintenance Plan (active maintenance requirements)
   - Visit Work Package (work scope and resource)
   - Long Term Plan (hangar and visit plan)

4. Execution
   - Production
     - Production Planning
     - Outside Processing

This section includes the following topics:
- Oracle Complex Maintenance, Repair, and Overhaul Standard Setup, page 2-73
- Oracle CMRO Approval Workflow Setup, page 2-77
- Oracle CMRO Module Setup, page 2-85

**Oracle Complex Maintenance, Repair, and Overhaul Standard Setup**

The CMRO Standard Setup involves assigning roles to AHL Super User, and setting up advanced properties and system profile options.
To assign roles and set up advanced properties:

1. Login to JTF using the System Administrator responsibility.

2. Click the Users link in the Home page.

3. Click the User Maintenance link.

4. In the Users page, query for the user that has the AHL Super User responsibility.

5. Click the Go button

6. Click the user name to navigate to the User Details page.

7. Click the Roles button.

   The User-Role Mapping page appears.

8. From the Available Roles column, select the following roles and move them to the Assigned Roles column:
   - AHL_ADMIN_ROLE
- AHL_OSP_ROLE
- AHL_USER_ROLE
- CSI_ADMIN_USER
- CSI_NORMAL_USER

User-Role Mapping

9. Click the Settings tab to set up the advanced properties.

10. Select the Properties folder, and then click the Advanced link.
    The Advanced - Properties page appears.

11. Select AHL from the View list.

12. Click the branding.default value, and verify that the value is Oracle Complex MRO.
To set up the system profile options:

1. Navigate to the System Profile Values window (System Administrator > System Profiles).

2. Set up the system profile options as indicated in the table below.

### System Profiles

<table>
<thead>
<tr>
<th>Profile</th>
<th>Site (Value)</th>
<th>Descriptions</th>
</tr>
</thead>
<tbody>
<tr>
<td>AHL: Application Usage Mode</td>
<td>Complex Maintenance Repair and Overhaul, Depot Repair, Preventive Maintenance</td>
<td>Set up the application usage mode.</td>
</tr>
<tr>
<td>AHL: Turn On Development Debug</td>
<td>Yes/No</td>
<td>Enable/disable debug session.</td>
</tr>
<tr>
<td>AHL: Turn on File Debug</td>
<td>Yes/No</td>
<td></td>
</tr>
</tbody>
</table>

**Note:** The Fleet Maintenance Program and Route Management modules enable users to define maintenance requirements and routes for both CMRO and Preventive Maintenance applications. Setting up the profile option AHL: Application Usage Mode
determines the user responsibility. Users can view only the routes, maintenance requirements, or unit effectivities associated with the selected application usage mode. Users can also define routes having the same number or maintenance requirements having the same title across different application usage modes.

Oracle CMRO Approval Workflow Setup

You can set up an Approval Workflow to approve maintenance programs, activities and routes. You can use the built-in Approval Workflow or you can create your own workflow, define a specific approval rule and create a list of approvers for each CMRO object. After setting up the profile options, if you do not specify an approval rule, the application uses the default approval rule.

The CMRO Approval Workflow setup includes:

- Setting up profile options.
- Creating approval users and roles.

Setting Up Profile Options

When you click the Advanced button, the maintenance programs, activities, and routes are automatically approved at creation. To set up an approval process, you must set up the system profile options as indicated in this table.

<table>
<thead>
<tr>
<th>Profile Options</th>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>AHL: Enable approval workflow for Routes</td>
<td>Yes</td>
<td>This enables the approval workflow for the routes.</td>
</tr>
<tr>
<td>AHL: Enable approval workflow for Maintenance Requirement</td>
<td>Yes</td>
<td>This enables the approval workflow for maintenance programs and activities.</td>
</tr>
<tr>
<td>AHL: Workflow Loop Counter</td>
<td></td>
<td>Requires a numeric value that defines how many times the notification will be re-sent if the user does not respond.</td>
</tr>
</tbody>
</table>
Profile Value Description

<table>
<thead>
<tr>
<th>Profile</th>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>AHL: Workflow Timeout Minutes</td>
<td>Requires a numeric value that defines the</td>
<td>-</td>
</tr>
<tr>
<td></td>
<td>period after which a workflow times out</td>
<td>-</td>
</tr>
<tr>
<td></td>
<td>when its progress is halted.</td>
<td></td>
</tr>
</tbody>
</table>

Creating Approval Users and Roles

To activate the enabled workflow, you must set up employees in Oracle Human Resources, create application users and define approval roles for these employees, and create approval rules for the different CMRO objects.

**Note:** The following setup steps are depending on the use of the seeded approval workflow. If you decide to create your own workflow, you must adjust these steps to the functionality of this workflow.

Defining Approval Employees in Oracle Human Resources

All approval users must be defined as employees in Oracle Human Resources.

**Note:** If you want to notify the approval user using email, then in addition to the application work list notification, you must also set up the email address for the employee in the Office Details window.

For more information on how to set up employees, refer to the Oracle Human Resources Implementation guide.

Creating Application User for Approval Employees

All approval employees must have an Oracle Applications login. When defining an application users you must associate the approval employee, employee (set up in Oracle HR) to that application user.

Creating Approval Roles

Associating the approval employees to a role is an optional step. If you have set up the employees in Oracle HR and created application users for them, you can associate the employees directly with an approval role. You can set up the following two types of approval roles:

Default Approval Role

CMRO provides a seeded default approval rule that is used when no object specific approval rule is set up. The default approval rule should be used when the same people in the same hierarchy will approve all CMRO objects. In this case, you only have to set
up one rule with one approval sequence. The default approval rule has also one approval hierarchy with a seeded role defined.

**To set up the role for the default approval rule:**

1. Navigate to the CRM Resource Manager responsibility, and then select Setup > Roles.

2. Click the Role Type field, and search for the JTF_RS_ROLE_TYPE value.

3. Create a role type code for the default approval role.

4. Navigate to Setup > Roles.

5. Create a role with the code AHL_DEFAULT_APPROVER.

   **Note:** The code must be defined as described or the default rule will not recognize this role. The role name can be user defined.

6. Associate the default approval role type code to this role.
Roles

Create additional roles if you need more than one level of approval. The role codes can be user defined for the additional roles used for the default approval rule.

**Note:** For CMRO approval, only one user can be associated with a role, otherwise the approval workflow will fail. Therefore, you must create as many roles as you have approvers. The sequence of notification will be defined in the approval rule setup.

General Approval Role

Perform the following setup steps if you have specific approval rules for the different CMRO objects:

1. Navigate to the CRM Resource Manager responsibility, and then select Setup > Roles.

2. Query for the JTF_RS_ROLE_TYPE value.

3. Create role type codes for the General Approval roles.

**Note:** You can create multiple role type codes for grouping the roles together, but you must create at least one role type code.
4. Navigate to Setup > Roles. Create a role for every possible approver.

5. Associate the appropriate approval role type code to the roles.

### Importing Resources

After you have created the employees and the roles, you must map the two together.

**Note:** As previously mentioned, only one employee can be assigned as a workflow approver. However, the same employee can be the designated approver for multiple roles.

**To import resources:**

1. From the CRM Resource Manager responsibility, navigate to Maintain Resources > Import Resources.

2. Select the approval employee. Click the Search button.

3. Click Create Resource. Select the appropriate role.

4. Click OK. Click Save Resource.
5. Click the Details button to associate this employee with an additional role.

6. Repeat these steps for all approval employees.

Creating Approval Rules in CMRO

You can use the seeded default approval rule, or specify an object-specific approval rule for the different CMRO objects. In the approval details, you can pick a role that you have set up, or a user that has been created as an employee in HR and associated with an application login. The sequence in the approval details defines the approval hierarchy.

To adjust the default approval rules:
1. Login to the JTF environment of CMRO.

2. Click the Administration link.

3. Click the Go button.

4. Click the Default AHL Rule link.
5. Add any additional roles or users to the approval details in sequence that you want the objects to be approved.

   **Note:** The first role is seeded. You can change the hierarchy or delete the seeded role if necessary.

6. Click the Apply button.

   **Note:** Do not add any values to the operating unit attribute. Custom values are currently not supported by CMRO and would cause the workflow to fail. Also, you cannot change the status of the default rule once it is set to Obsolete.

**To define object specific approval rules:**

1. Login to CMRO.

2. Click the Administration link.

3. Click the Approvals tab.

4. Click the Create button, and the Create Approval Rule page appears.

   **Create Approval Rule**

5. Enter the Approval Rule Name (required).

6. Select Complex Maintenance, Repair, and Overhaul in the Application Usage field (required).

7. Select the required value from the Approval Rule For drop-down list.
8. (Optional) Select an Operating Unit.

9. Enter the Start Date (required).

10. (Optional) Enter a Description.

11. Click the Apply button.

12. Add roles or users to the approval details in the sequence in which you want your objects to be approved.

13. Select Active from the Status drop-down list.

14. Click the Apply button.

**Workflow Process Mapping**

The final step in the approval workflow setup is to map the object with a workflow. Oracle recommends that you use seeded workflow that is delivered with CMRO. If you invoke a customized workflow, it may interfere with the CMRO Deferral workflow. The CMRO Deferral may be performing several background processes or integration required for the standard functionality. If you try to replace this workflow with a customized one, the deferral functionality is affected.

**To map the workflow with the CMRO object:**

1. Login to the JTF environment of CMRO.

2. Click the Administration link.

3. Click the Workflow tab.

4. If you want to use the same workflow for all of your objects, leave the object field empty, otherwise choose the object, which you want to add from the drop-down list.

5. Define the desired workflow in the Process Name field. The CMRO default workflow is called ASO Generic Approval Process.
Workflow Process Mapping

6. Select Complex Maintenance, Repair, and Overhaul from the Application Usage drop-down list box.

7. Select Yes or No from the Active list box.

8. Click the Apply button.

The Approval Workflow
When a maintenance program, activity or route is sent for approval the user defined in the approval role is notified by email, if it has been set up at employee creation, or with an entry in the Worklist in Oracle Applications. From the notification, the user can navigate to the notification details and approve the program, activity or route. The workflow moves sequentially through all of the roles defined in the approval rules until the last user has sent his approval. After the last approval has been sent, the status of the approved object will be changed from Approval Pending to Complete.

Oracle CMRO Module Setup
Oracle Complex Maintenance, Repair, and Overhaul enables maintenance organizations to meet customer expectations, and draw maximum benefit by improving the operational readiness of equipment.

Oracle CMRO Module setup includes:
Setting Up Automatic Visit Scheduling and Auto-Packaging

The automated visit forecasting process is a tool for the maintenance planners to group maintenance requirements together to support both a rough-cut visit plan as well as an operational maintenance plan (Primary Plan), based on a maintenance organization. This enables the planner to approach the plan and focus on the exceptions for both short and long term planning. This feature is used primarily for heavy maintenance such as letter checks and modifications. It is typically used to forecast 12-18 months into the future.

There are two components to the Auto Visit Planning process:

• Process Flight Visit Schedules API (Short Term Planning)
• Create Primary Visits (Long Term Planning)

**Important:** Only visits with a status of Planning can be used with this feature.

This functionality will improve the creation and scheduling of visits for both line and base maintenance.

For base maintenance, there is a new Autovisit Planning Workbench where users can define a processing hierarchy by master configuration, program type, subtype and a
date range. The user can then launch and monitor concurrent programs which will:

- Create new visits based on Primary Visit MRs.
- Cancel existing visits.
- Add UMP MRs to existing visits.

For line maintenance, users can define parameters for creating operational visits based on the flight schedule and maintenance capability of arriving and departing stations. The user can define both generic and specific parameters for flights which will:

- Create pre and post-flight visits.
- Create transit checks which will span an aircraft's downtime duration.
- Adjust visits based on flight changes.
- Cancel visits based on flight cancellations and re-routes.
- Notify users of changes to specific visits and flight associations.

This section includes the following topics:

- Prerequisites for Auto Visit Planning
- Defining Service Categories
- Defining Flight Categories
- Defining Visit Types
- Defining Primary Maintenance Requirements

**Defining Service Categories**

You must define service categories that will be used with the Autovisit creation and fleet forecasting processes. The service category is the highest level of service that the department can perform. Therefore, the department can accomplish this level of service as well as any lower valued service. The service category lookups must use a numerical value: 1 is the highest.

**Note:** If the service category is not defined for the maintenance requirement, then the system will assume that the MR can be accomplished at any department.

There are 6 seeded values that are extensible which can be edited for your use:

- 1: Category 1
• 2: Category 2
• 3: Category 3
• 4: Category 4
• 5: Category 5
• 6: Category 6

**Relationship of Department Service Categories and Maintenance Requirements**

If a Department is assigned 2: Category 2, then it will have a ranking of 2. This means that a department can provide service for category 2 and below.

However, there is an *inverse* relationship with the department’s service category and the department’s capability to perform maintenance.

For example, an MR has been defined with a Service Category of 2. This MR requires that the department must have a service category of *at least* 2 to perform this level of work. Therefore, any department that has a category of 2 or 1 can accomplish this MR.

**Examples**

• Category 3 MR: Can be accomplished in departments with a service category of 3, 2, or 1.

• Category 1 MR: Can be accomplished in departments with a service category of 1 only (highest value).

• Category 6 MR: Can be accomplished in departments with a service category of 6, 5, 4, 3, 2, or 1.

**Defining Flight Categories**

You must set up the Flight Category attribute that is used in the Flight API. This attribute will be used in the Create Operational Visits page.

1. Navigate to the Application Object Library Lookups page (Application Developer > Application > Application Object Library).

2. Search for the AHL_FLIGHT_CAT_CODES value in the Type field.

   Verify that the seeded ETOPS code exists. This flight category code is used with the AutoVisit Planning feature.
3. If the ETOPS code does not exist, add it using the following values:
   - Code: ETOPS
   - Meaning: Extended Operations
   - Description: Allows extended flight operations of 120 minutes or greater

4. Save your work.

**Defining Visit Type Lookups**

Visit type lookups can be created for specific master configurations and should be created in such a way that the defined stage and unplanned estimates apply to all relevant maintenance requirements.

Visit types are often created for the primary heavy maintenance requirements, which determine the basic duration and structure of the visit, and are used as scheduling opportunities for many other smaller requirements. Visit types may also be created to represent other maintenance events such as transit visits or overnight repairs.

**To define visit type lookups:**

1. Navigate to the Application Object Library Lookups page (Application Developer > Application > Application Object Library).

2. Search for the AHL_PLANNING_VISIT_TYPE type.
3. Click the **Add** button to add new visit types.

Define each visit type to include:

- Code
- Meaning
- Description
- From Effective Date (required)
- To Effective Date (optional)

4. Save your work.

**Defining Visit Type Profiles**

Visit types profiles are used to build maintenance visit templates during the planning process and identify default the visit duration, the stages in which the maintenance will be accomplished, and any unplanned requirement estimates.

Visit types are created for specific master configurations, representing a known type of maintenance event with a rough idea about expected work scope, visit duration and visit structure. Use the Create Visit Types page to define visit type profiles; use the Edit Visit Types page to edit existing visit type profiles.

1. Navigate to the Create Visit Types page (Administration > Visit Types > Visit Types).
2. Click the **Create** button, and the Create Visit Types page appears.

3. Select or enter values for these fields:
   - Visit Type (required)
   - Description (optional)
   - Transit Type - select if the visit type is for transit (optional)
     
     **Important:** Do not select the Component Type check box for the Auto Visit Planning process.
   - Master Configuration (required for non transit and component types)

4. (Optional) Enter a stage number.

5. Enter a stage name.

6. (Optional) Enter the duration of each stage (in hours).
   
   The total hours for the stages will be reflected in the Duration field on the page.

7. Save your work.

   See Visit Work Packages for more information regarding stages.

**Defining Primary Maintenance Requirements**

Define the primary maintenance requirements.

1. Use the Create Maintenance Requirements page (Engineering > Fleet Maintenance Program > Overview > Create) to create primary MRs that will be used by the Autocreate Visit process to automatically create maintenance visits.
2. Enter or select values for the following required fields:

- **Title**
- **Category**
- **Program Type**: This field will be used by the Autovisit process to create primary visits.
- **Implement Status**: Select Mandatory. Only MRs with an Implement Status of Mandatory are used during the Autovisit create process.
- **Repetitive**
- **Whichever comes**
- **Effective from**
- **Program Subtype**: This field will be used by the Autovisit process.
- **On Wing**
- **Service Category**: This field is used by the Autovisit UE assignment process to evaluate if a visit department is capable of performing the MR.

**Defining Maintenance Organizations Used in Auto Visit Planning**

The Create Primary Visits process will create new visits based on Unit Effectivity records that originate from Primary MRs. The maintenance organizations where an MR
can be accomplished are defined in the MR definition. These definitions will be used in the Auto Visit creation process to set the maintenance organization and department in the visit header.

Important: The maintenance organization must be defined to create a visit using the Auto Visit process.

Use the Update Maintenance Requirement page (Engineering > Fleet Maintenance Program > Overview) to define the maintenance organization for the MR that will be used during the Auto Visit create process.

The maintenance organizations in an MR can be defined in one of these two ways:

- Based on the Operating Organization: The appropriate maintenance organization and maintenance department can be defined during fleet creation.
  
  Note: There can be only one maintenance organization and maintenance department defined per operating organization.

- Not Based on the Operating Organization: The maintenance organization and maintenance department are defined regardless of the operating organization.

See Defining Maintenance Organizations (in fleet chapter)

Defining a maintenance organization:

1. Navigate to the Update Maintenance Requirement page (Engineering > Fleet Maintenance Program > Overview) to define the maintenance organization for the MR that will be used during the Auto Visit create process.

2. Select or enter values in one of these fields:
   - Organization
   - Master Configuration
   - Visit Type

3. You can also optionally select a Flight Category to further narrow your search.

4. Click the Go button to retrieve the MRs that meet the search criteria.
The following conditions apply to maintenance organization definitions:

- There can only be one maintenance organization and department defined per operating organization. However, multiple operating organizations can be set up for different regions of operations.

- There can be a single row created that defines a maintenance organization and department, regardless of the Operating Organization for the UE.

  **Important:** Only one maintenance organization row will display.

### Defining Maintenance Departments

The Department capabilities can be defined for a maintenance department and will be applied to a visit as the Service Category attribute. These capabilities can then be used by the Auto Visit process to evaluate if an MR can be scheduled to an existing visit.

1. Navigate to the Edit Department Location page (Administration > Department Location > Search for the department).

   The Edit Department Location page appears.

2. Click the **Edit** button for the department that you want to update, and the Update Department Location page appears.
3. (Optional) Select or enter new values for these fields:
   - Calendar
   - Sub Inventory and Physical Locator
   - Shift Number
   - Work Days (pattern - associated to the Shift Number)

4. (Optional) Select a value in the Max Service Category field.
   The Max Service Category is the highest level of service that the department can perform. Therefore, the department can accomplish this level of service as well as any lower valued service. The service category lookups must use a numerical value: 1 is the highest.
   The seeded values are:
   - 1: Category 1
   - 2: Category 2
   - 3: Category 3
   - 4: Category 4
   - 5: Category 5
   - 6: Category 6

   Note: If a Max Service Category is not defined for a department, then the department will be able to accomplish all levels of maintenance, and will be assigned to MRs of any service category.
See Defining Service Categories, *Oracle Complex Maintenance, Repair, and Overhaul Process Guide* to select the correct user-defined value.

5. If you do not select a Max Service Category, the system will deem that the department can accomplish all levels of maintenance, and will assign MRs with any service category.

6. Click the **Apply** button to save your work.

### Setting Up Complex Assembly Maintenance

This section contains the setup tasks required to use the complex assembly maintenance feature.

### Prerequisites for Complex Assembly Maintenance

Perform the following setup tasks to use the complex assembly maintenance feature.

<table>
<thead>
<tr>
<th>Prerequisite Setup Task</th>
<th>Role Performing Task</th>
<th>Navigation</th>
</tr>
</thead>
<tbody>
<tr>
<td>1. Define AHL lookups for:</td>
<td>Engineering</td>
<td>Application Developer &gt; Application &gt; Lookups &gt; Application Object Library</td>
</tr>
<tr>
<td>• Visit Types</td>
<td></td>
<td></td>
</tr>
<tr>
<td>• Service Category</td>
<td></td>
<td></td>
</tr>
<tr>
<td>• Program Type</td>
<td></td>
<td></td>
</tr>
<tr>
<td>• Program Subtype</td>
<td></td>
<td></td>
</tr>
<tr>
<td>2. Define Visit Type profiles.</td>
<td>Engineering</td>
<td>Administration &gt; Visit Types</td>
</tr>
<tr>
<td>• Define duration for the visit.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Prerequisite Setup Task</td>
<td>Role Performing Task</td>
<td>Navigation</td>
</tr>
<tr>
<td>----------------------------------------------------------------------------------------</td>
<td>----------------------</td>
<td>---------------------------------------------------------------------------</td>
</tr>
<tr>
<td>4. Define maintenance department and space capabilities.</td>
<td>Engineering</td>
<td>Administration &gt; Department Location &gt; Create (B)</td>
</tr>
<tr>
<td>• Define the Max Service Category values.</td>
<td></td>
<td>Administration &gt; Department Location &gt; Edit Department Location</td>
</tr>
<tr>
<td>• Define department spaces.</td>
<td></td>
<td>Administration &gt; Spaces</td>
</tr>
<tr>
<td>Define space capabilities by adding master configurations and visit types.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>5. Create master configurations, unit configurations, and product classifications.</td>
<td>Engineering</td>
<td>Configuration &gt; Master Configuration &gt; Overview &gt; Search Master Configuration &gt; Create (B)</td>
</tr>
<tr>
<td>7. Define department spaces.</td>
<td>Engineering</td>
<td>Administration &gt; Spaces &gt; Search Spaces &gt; Create (B)</td>
</tr>
<tr>
<td>• Add the Master Configuration item and Visit Type.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Prerequisite Setup Task</td>
<td>Role Performing Task</td>
<td>Navigation</td>
</tr>
<tr>
<td>-------------------------</td>
<td>----------------------</td>
<td>------------</td>
</tr>
<tr>
<td>8. Create the fleet maintenance program and define maintenance requirements.</td>
<td>Engineering</td>
<td>Engineering &gt; Fleet Maintenance Program &gt; Overview &gt; Search Maintenance Requirement &gt; Create (B)</td>
</tr>
<tr>
<td>• Define tolerance before and after thresholds.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>• Define Min Service Category.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>• Setup Primary visit MRs and define:</td>
<td></td>
<td></td>
</tr>
<tr>
<td>• Single visit type for mandatory MRs.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>• Operating organization or maintenance organization and department.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>• Program Type and Program Subtype</td>
<td></td>
<td></td>
</tr>
<tr>
<td>9. Create maintenance forecast.</td>
<td>Engineering</td>
<td>-</td>
</tr>
<tr>
<td>• Initialize MRs.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>• Run the Build Unit Effectivities (BUE) program.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>10. Analyze maintenance history using Demantra to generate non-routine estimates.</td>
<td>Reliability Engineer</td>
<td>-</td>
</tr>
<tr>
<td>11. Update MR NR Profile using the latest non-routine estimates.</td>
<td>Reliability Engineer</td>
<td>Planning &gt; Unit Maintenance Plan &gt; Non-routines &gt; Search Non-routine &gt; Update (icon) Update Non-Routine</td>
</tr>
<tr>
<td>Prerequisite Setup Task</td>
<td>Role Performing Task</td>
<td>Navigation</td>
</tr>
<tr>
<td>----------------------------------------------------------------------------------------</td>
<td>-------------------------------</td>
<td>-------------------------------------</td>
</tr>
<tr>
<td>12. Update the BOM calculations in ASCP to include the latest non-routine estimates.</td>
<td>Reliability Engineer</td>
<td>-</td>
</tr>
<tr>
<td>13. Generate non-routine removal rates (Mean Time Between Unscheduled Removal [MTBUR]) for complex assemblies.</td>
<td>Reliability Engineer</td>
<td>-</td>
</tr>
</tbody>
</table>

**Setting Up Document Index**

The Document Index module in Oracle Complex Maintenance, Repair, and Overhaul is the central repository for managing all maintenance documents.

Maintenance personnel can:

- Access an online catalog of documents used in maintenance, repair, and overhaul operations.
- Receive, distribute, and control revisions in technical documentation.
- Search the database to quickly refer to a document.
- Create new documents or document revisions.
- Associate subtypes to document types for easy identification.
- Upload electronic documents.

Maintenance document management involves tracking documents and their revisions, validating document references from multiple levels of maintenance operations, and making them easily accessible to the maintenance personnel.

Setting up Document Index includes defining the lookup values as indicated.

**Note:** Lookup codes fall within three categories: extensible, user defined, and system defined. If a lookup code is extensible, the existing
lookup codes cannot be modified, but new codes can be added to the table. If lookup codes are user defined, all codes can be modified. If lookup codes are system defined, the existing codes cannot be modified, and new codes cannot be added to the table.

To define lookups for Document Index:


2. Define the lookups as outlined in this table.

<table>
<thead>
<tr>
<th>Attribute</th>
<th>Lookup</th>
<th>Suggested Values</th>
<th>Access Level</th>
</tr>
</thead>
<tbody>
<tr>
<td>Operator</td>
<td>AHL_OPERATOR_TYPE</td>
<td>Operator, Owner (User defined)</td>
<td>User</td>
</tr>
<tr>
<td>Document Type</td>
<td>AHL_DOC_TYPE</td>
<td>Aircraft, Engine (User defined)</td>
<td>Extensible</td>
</tr>
<tr>
<td>Media Type</td>
<td>AHL_MEDIA_TYPE</td>
<td>E-File, CD-ROM, On-line, Paper</td>
<td>Extensible</td>
</tr>
<tr>
<td>Status</td>
<td>AHL_SUBSCRIBE_STATUS_TYPE</td>
<td>Active, Not available</td>
<td>User</td>
</tr>
<tr>
<td>Sub-Type</td>
<td>AHL_DOC_SUB_TYPE</td>
<td>Airworthiness Directives, Service Bulletin</td>
<td>User</td>
</tr>
<tr>
<td>Revision Type</td>
<td>AHL_REVISION_TYPE</td>
<td>Temporary Revision, Full Revision</td>
<td>User</td>
</tr>
<tr>
<td>Frequency Type</td>
<td>AHL_FREQUENCY_TYPE</td>
<td>Quarterly, Weekly, Yearly</td>
<td>User</td>
</tr>
</tbody>
</table>
Setting Up Route Management

The Route Management module in Oracle CMRO provides a single interface to manage all maintenance tasks.

Maintenance personnel can:

- Prepare and maintain work instructions.
- Search the database for a specific operation to view or edit.
- Search for tasks to be performed based on the Maintenance Technician role of Heavy Maintenance and Engine-Shop Technician, Line and Transit Maintenance Technician, and Data Clerk.
- For more information regarding the Maintenance Technician role, Oracle Complex Maintenance, Repair, and Overhaul User’s Guide.

- Create an operation or define instructions to perform a maintenance task.
- Search for maintenance routes to view or edit routing information.
- Create a maintenance route.
- Associate major and sub zones in a system to a product type to facilitate tracking of maintenance operations on complex electromechanical systems.
The intuitive user interface of Oracle CMRO is designed to enable maintenance personnel to handle operational needs as effortlessly and quickly as possible.

Before setting up route management, you must ensure that:

- ASO Resource is set up.
- BOM Resource is set up.

Setting up route management includes:

- Defining lookup values.
- Setting up key flexfields.
- Setting up descriptive flexfields.

**To define lookups for route management**

1. Access the Application Developer responsibility.


3. Define the lookups as outlined in this table.

<table>
<thead>
<tr>
<th>Attribute</th>
<th>Lookup</th>
<th>Suggested Values</th>
<th>Access Level</th>
</tr>
</thead>
<tbody>
<tr>
<td>Operation Type</td>
<td>AHL_ROUTE_TYPE</td>
<td>Aircraft, Engine, Ground support</td>
<td>User</td>
</tr>
<tr>
<td>Major Zone</td>
<td>AHL_ZONE</td>
<td>Cargo Compartment, Cockpit</td>
<td>User</td>
</tr>
<tr>
<td>Sub Zone</td>
<td>AHL_SUB_ZONE</td>
<td>AFT Fuselage, Cabin</td>
<td>User</td>
</tr>
<tr>
<td>Status Type</td>
<td>AHL_SUBSCRIBE_STATUS_TYPE</td>
<td>Active, Available</td>
<td>User</td>
</tr>
<tr>
<td>Sub-Type</td>
<td>AHL_DOC_SUB_TYPE</td>
<td>AD, SB</td>
<td>User</td>
</tr>
<tr>
<td>Revision Type</td>
<td>AHL_REVISION_TYPE</td>
<td>Temporary, Full Version</td>
<td>User</td>
</tr>
</tbody>
</table>
To set up key flexfields

**Note:** To enable route management, you must set up a key flexfield to define the System attribute.

**Validate Existence of Route Flexfield**
1. Access the Application Developer responsibility.
2. Navigate to Flexfield > Key > Segments.
3. Query for the AHL Route in the Flexfield Title field.

Add segments to this flexfield
1. Click the **Segments** button to add segments to this flexfield.
2. Enter information for the System flexfield segment.
Create Value Sets to be used by Flexfield Segments

1. Click the **Value Set** button.

2. Define a value set name.

3. Select List of values from the List Type drop-down list.


5. Select Char in the Format Type drop-down list.

6. Select Independent in the Validation Type drop-down list.
7. Update the flexfield segments with the value sets.

Create values for Value Sets
1. Navigate to Flexfield > Key > Values.
2. Find the value sets for the system flexfield.
3. Add the desired values to the value set.

To set up descriptive flexfields

Validate existence of Route Flexfield
1. Access the Application Developer responsibility.

2. Navigate to Flexfield > Descriptive > Segments.

3. Query for Flexfield Title AHL_ROUTES_B. Query should return the record.

Add segments to this flexfield
1. Click the Segments button.

2. Enter the records for the System flexfield segment.

3. Select the Enable check box.

Perform the following steps only if a relevant value set is not defined.

Create Value Sets to be used by Flexfield Segments
1. Click the Value Set button.
2. Enter the value set name.

3. Select List of Values as the list type.

4. Select No Security as the security type.

5. Select one of these options in the Format Type field:
   - Char
   - Number
   - Date

6. Select Independent in the Validation Type drop-down list.

7. Update the flexfield sets with the value sets.

Create values for Value Sets
1. Navigate to Flexfield > Descriptive > Values.

2. Find the value sets for the system flexfield.

3. Add the desired values to the value set.

Compile the Flexfields
1. Click the Compile button to compile the flexfields.

2. Select the Freeze check box, if it is not checked. (This check box is also used for editing flexfields. To edit, clear this check box and then proceed further).

Setting Up Master Configurations

The Master Configuration module in Oracle CMRO provides models of electromechanical system assemblies. A master configuration model will form the basis of a unit in combination with business rules that specify the systems and subsystems that may be included in the assembled unit.

Maintenance personnel can:
- Search the database for master configurations of electromechanical system assemblies.
- Create system assembly master configurations.
- Create a Minimum Equipment List (MEL) and a Configuration Deviation List (CDL) for equipment.
• Search for alternate parts that may be used in place of specified components in an assembly.

Before setting up the Master Configuration module, you must ensure that:
• Inventory (Item Master) setup is complete.
• Approval Workflow is set up (This step is optional if the user selects the default approval workflow).

Setting up the Master Configuration includes defining the lookup values.

To define lookups for the master configuration module:
1. Access the Application Developer responsibility.


3. Define the lookups as outlined in this table.

<table>
<thead>
<tr>
<th>Attribute</th>
<th>Lookup</th>
<th>Suggested Values</th>
<th>Access Level</th>
</tr>
</thead>
<tbody>
<tr>
<td>Rule code (Position ratio list)</td>
<td>AHL COUNTER RULE_TYPE</td>
<td>Bird Strike, Heavy Landing</td>
<td>User</td>
</tr>
<tr>
<td>Alternate Part Interchangeability Type</td>
<td>AHL_INTERCHANGE_ITEM_TYPE</td>
<td>1-Way, 2-Way, No Interchange, Superseded By</td>
<td>Extensible</td>
</tr>
<tr>
<td>Position reference</td>
<td>AHL_POSITION_REFERENCE</td>
<td>Forward, Inboard, Left, Lower, Outboard, Position 1, Position 2, Position 3, Right, and Upper</td>
<td>User</td>
</tr>
</tbody>
</table>
Setting Up Unit Configurations

The Unit Configuration module in Oracle CMRO enables organizations to describe the structure of an assembled electromechanical system. The as-constructed configuration of an assembly will determine the specific maintenance program required to ensure the operational readiness of that unit.

This module also enables CMRO personnel with super user security to quarantine a unit configuration after an aircraft accident.

Maintenance personnel can:

- Initiate proper maintenance activities to resolve issues.
- Create unit configurations from existing master configurations.
- Create an MEL or CDL for affected unit configurations.
- Search for unit configuration records that exist in the database.
- Add new part information to the database.
- View and update existing part information.

The Unit Configuration module in Oracle CMRO is a key feature that enables maintenance organizations to determine services required. Even if two units have the same part number, or belong to the same product family, their configurations are
normally different due to the operation and maintenance history of each unit. The Unit Configuration provides models of individual tracked parts to support unit-specific information.

Before setting up the Unit Configuration module, you must ensure that the Master Configuration module is set up and products are available for association at the unit level.

Setting up the Unit Configuration includes setting up attributes as indicated below.

**To set up attributes**

1. Change responsibility to Oracle Install Base Administrator.

2. Click Setups > Extended Attribute Template. The Extended Attributes window appears.

3. Set up the attributes as indicated in the table below.

**Extended Attributes Window**

<table>
<thead>
<tr>
<th>Attribute Code</th>
<th>Attribute Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>AHL_MFG_DATE</td>
<td>AHL_MFG_DATE</td>
<td>AHL_MFG_DATE</td>
</tr>
<tr>
<td>AHL_TEMP_SERIAL_NUM</td>
<td>AHL_TEMP_SERIAL_NUM</td>
<td>AHL_TEMP_SERIAL_NUM</td>
</tr>
</tbody>
</table>

4. Save your work.

**Overview of Minimum Equipment Lists (MEL) and Configuration Deviation Lists (CDL)**

The MEL and CDL functionality identifies equipment, as opposed to structural items, that can be inoperative or missing on aircraft—but still enable the aircraft to maintain airworthiness. This includes items such as radios, seats, lights, air conditioning, heaters, and indicators—but not structural items such as engines or controls. These items are called provisos, and under certain conditions, can be inoperative. Limitations may be required as to how the aircraft is operated regarding ice conditions, night flights, or altitude limits. MEL addresses defective equipment, and CDL addresses missing parts in an aircraft.

The MEL is based on the Master Minimum Equipment List (MMEL) which is a list of equipment that the National Airworthiness Authority (such as the FAA or CASA) has determined that may be inoperable under certain operation conditions, but still provides an acceptable level of safety. The MMEL contains the conditions, limitations, and procedures required to operate the aircraft with these items inoperable.

The CDL is developed by the aircraft manufacturer, and identifies secondary airframe
and engine parts on an aircraft that may, under certain conditions, be missing from the aircraft and still allows the aircraft to maintain its airworthiness with certain limitations. The aircraft manufacturer submits the CDL to the Aircraft Certification Office for approval.

MEL and CDL instructions can be added to the CMRO planning process to enable you to defer non-routine maintenance. Maintenance and Operation (M and O) procedures are created to ensure that the correct steps and restrictions are followed when a requirement is deferred.

**Important:** MELs are maintained at the unit configuration level.

The following diagram outlines the setup required to use the MEL and CDL feature:
**Setting Up a MEL/CDL**

To set up a MEL and CDL, follow these prerequisite steps:

1. Define the profile option of AHL:Service Request Type. This profile is used to create the Maintenance and Operation (M and O) procedures.

2. Define the required ATA codes for relevant configuration positions. These lookups can be found in the Application Object Library for type AHL_ATA_CODE.
3. Define applicable ATA codes for each position when creating a master configuration.

4. Navigate to M and O Procedures. These procedures contain the non-routine maintenance requirements to be deferred per the MEL and CDL guidelines affecting the production process.

**Setting Up Configuration Access Control**

In case of an aircraft accident, a user with super user security can quarantine a unit configuration. This quarantine enables the freezing of the unit configuration and will not allow changes to the made to the configuration which could impact the investigation.

There are some prerequisites that must exist before this feature can be used:

- The CMRO system administrator edits the configuration access control workflow using the Approvals page.

- The CMRO system administrator creates a super user role to be used for configuration access control.

  The system administrator assigns the AHL_UC_QUARANTINE_ROLE to the appropriate super user.

- The CMRO system administrator creates the super user role using the User Maintenance page.

**Using Configuration Access Control**

This diagram illustrates the process flow for the activation and deactivation steps for quarantining a unit configuration:
Once the quarantine request has been approved, the status changes to Quarantine.

### Transactions That Are Allowed on a Quarantined Unit Configuration

The following lists the types of transactions that are allowed when a unit configuration has been quarantined:

- Unit Maintenance Visit Association
- Issue material transaction from production
- Return material transaction from production
Important: All other transactions are denied while the unit configuration is quarantined.

Deactivating the Quarantine Status

Once the super user has deactivated the quarantine for the unit configuration, all restrictions are removed and all transactions are allowed. The status of the unit configuration returns to the status prior to the quarantine.

Setting Up Fleet Maintenance Program

The Fleet Maintenance Program module in Oracle CMRO enables maintenance organizations to record, organize, and plan maintenance requirements. Maintenance planners can create maintenance requirement records and attach attributes to these records. The attributes attached to the record enables maintenance planning and increased operational efficiency while accomplishing a requirement.

Maintenance planners can:

• Search the database for a specific maintenance requirement for reference, or for editing purposes.

• Create a maintenance requirement record in the database.

• Attach documents, maintenance routes, actions, effectivities, and maintenance requirement relationships to the record.

• Create revisions for maintenance requirements that are complete.

• View items that are affected by a maintenance requirement.

The Oracle CMRO Fleet Maintenance Program module serves as a repository for scheduled maintenance and associated information.

Before setting up the Fleet Maintenance Program, you must ensure that the following has been set up:

• Lookup values.

• System profile options in Oracle Application: Profile system value.

• Route Management.

• Product Classification.

• Master Configuration.

• Unit Configuration.
• ASO Visit Work Package.

Setting up the Fleet Maintenance Program includes defining the lookup values.

To define lookups for the Fleet Maintenance Program:
1. Access the Application Developer responsibility.
3. Define the lookups as outlined in this table. Optionally, you can add values to these lookups as required.

<table>
<thead>
<tr>
<th>Attribute</th>
<th>Lookup</th>
<th>Suggested Values</th>
<th>Access Level</th>
</tr>
</thead>
<tbody>
<tr>
<td>Program Type</td>
<td>AHL_FMP_MR_PROGRAM_TYPE</td>
<td>Corrosion Prevention, Progressive Maintenance, Company Test, Phase Check, etc.</td>
<td>Extensible</td>
</tr>
<tr>
<td>Category</td>
<td>AHL_FMP_MR_CATEGORY</td>
<td>Power plant, airframe, component, ground equip., etc.</td>
<td>Extensible</td>
</tr>
<tr>
<td>Program Subtype</td>
<td>AHL_FMP_MR_PROGRAM_SUBTYPE</td>
<td>A, B, C</td>
<td>Extensible</td>
</tr>
<tr>
<td>Action</td>
<td>AHL_FMP_MR_ACTION</td>
<td>Email Test Results, Reset Overhaul Counter, Test</td>
<td>Extensible</td>
</tr>
</tbody>
</table>
Setting Up the Unit Maintenance Plan

The Unit Maintenance Plan module in Oracle CMRO ensures that all maintenance requirements are met on or prior to their due date. It also provides demand estimates over a planning time window by forecasting the due date of maintenance requirements associated with a unit. It searches and displays maintenance requirements that are due for an equipment unit and provides maintenance personnel instant access to maintenance requirements, due date estimation, accomplishment history, and planning information for a unit configuration.

Maintenance personnel can:

• Maintain utilization forecasts.

• View the serviceable time remaining of a unit.

• Model repetitive maintenance requirements over a specified time period.

• Calculate the due dates of maintenance requirements.

• Associate maintenance requirements to a visit.

The Unit Maintenance Plan serves as a repository of the maintenance requirements related to units and any related subassemblies or components. It also enables the forecasting of usage to determine due dates for fleet maintenance activities.

Before setting up the Unit Maintenance Plan, you must ensure that the following have
been set up:

- Lookup value in Oracle Application.
- System profile in Oracle Application: Profile system value.
- Product Classification.
- Master Configuration.
- Unit Configuration.
- ARO Visit Work Package.

Setting up Unit Maintenance Plan includes setting up system profile options.

**To set up the system profile options:**

1. Navigate to System Administrator > System Profile Values. The System Profile Values page appears.

2. Set up the following system profiles:
   - AHL: Maximum Planning Window (Number)
   - AHL: Maximum Planning Window (UOM)
   - AHL: Minimum maintenance opportunity duration in minutes required for scheduling a visit
   - AHL: Consider Department Conflicts

These profile options determine the period that is taken into account when calculating the due date and repetitive MR in the Unit Maintenance Plan (UMP). For example, the user may set the following values for the profile options:

AHL: Maximum Planning Window (Number) = 2
AHL: Maximum Planning Window (UOM) = Years

This means that the rolling planning windows in the UMP is two years. The concurrent program used to calculate the due date and repetitive MR will calculate all due dates within two years starting from the calculation date (current date).

**Status Groups and Transitions for Handling Non Routine transactions**

You can define a status group and attach to it all the Service Request statuses that you plan to use in CMRO Application. The application setup allows you to define status transitions, but these can be left empty. Transitions define the permitted changes from one service request status to another.
Only filtered statuses should display in the drop-down menu in the Non-routine Details region of the Update Non-routine page. That is, only those statuses, which belong to a particular status group, which is attached to a particular SR type. Else all the statuses should be shown.

For more information on Status Groups and Transitions and their setups, refer to Basic Service Request Setups chapter in Oracle TeleService Implementation and User Guide.

**Concurrent Program Setup**

- Program: Building Unit Effectivities
- Short Name: AHLUEFF
- Application: Oracle Complex MRO
- Description: Building Unit Effectivities

**Setting Up Visit Work Package**

The Visit Work Package (VWP) module provides planning capabilities including creation, organization, and scheduling of maintenance visits based on maintenance requirements. It enables the creation and management of visit templates based on equipment types enabling efficient visit package creation for equipment units of a type. The Visit Work Package permits the association of tasks with visits and visit templates, and the definition of the task hierarchy and cost structure.

Maintenance planners can:

- Create maintenance visit records, new, or from a template.
- View and update existing visit records.
- Associate tasks with visits: planned tasks, tasks that are required but not scheduled, and ad hoc tasks that are not associated with maintenance routes.
- View and update tasks associated with a visit.
- Create visit templates, new, or from an existing visit record.
- View and update existing visit templates.
- View and update visit template tasks.
- Create shift schedules for department workers based on planned visits.
- View existing department shifts.

The Visit Work Package enables maintenance planners to organize and execute a maintenance visit for an equipment unit.
Before setting up the VWP, you must:

- Verify that Oracle Projects has been set up. VWP exports objects to Oracle Projects.

- Verify that Oracle HRMS has been set up. VWP uses the organization information contained in Oracle HRMS.

- Verify that Oracle Installed Base has been set up. VWP uses the item instance information maintained by Installed Base.

- Verify that Oracle Inventory has been set up. VWP uses the inventory information to describe maintainable asset types.

- Verify that Oracle Customer Support has been set up. VWP associates service requests with maintenance visit tasks.

- Verify that the Unit Maintenance Plan module has been set up. VWP associates a unit maintenance plan maintenance request to VWP.

- Verify that the Fleet Maintenance Program module has been set up.

- Create project templates.

Setting up the VWP includes:

- Setting up system profile options.

- Defining lookups.

**To set up System Profile Options:**

1. Navigate to System Administrator > Profile > System> System Profile Values. The System Profile Values page appears.

2. Set up the following system profile options:

   - **AHL_DEFAULT_PA_TEMPLATE_ID**: To store the default value of project template ID for a visit.

   - **AHL_DEFAULT_NUMBER_OF_STAGES**: To store the maximum number of stages for a visit. This value is used in both engineering and planning related to the visits and the routes in a maintenance requirement.

   - **AHL: Default Project Template ID**: The name of the project template that will be used as the default template.
To define lookups for Visit Work Package:

1. Access the Application Developer responsibility.


3. Define the lookups as outlined in this table.

<table>
<thead>
<tr>
<th>Attribute</th>
<th>Lookup</th>
<th>Suggested Values</th>
<th>Access Level</th>
</tr>
</thead>
<tbody>
<tr>
<td>Visit Type</td>
<td>AHL_PLANNING_VISIT_TYPE</td>
<td>A-Check, B-Check, C-Check</td>
<td>User</td>
</tr>
<tr>
<td>Category</td>
<td>AHL_LTP_SPACE_CATEGORY</td>
<td>Category 1, Category 2…</td>
<td>Extensible</td>
</tr>
<tr>
<td>Hour List</td>
<td>AHL_VWP_HOURS</td>
<td>00, 01…</td>
<td>User</td>
</tr>
<tr>
<td>Visit Priority</td>
<td>AHL_VWP_VISIT_PRIORITY</td>
<td>1,2,3,4…</td>
<td>User</td>
</tr>
</tbody>
</table>
Setting Up Long Term Planning

The Long Term Planning module is used by the maintenance planner to schedule maintenance requirements in maintenance visits, based on the optimal use of resources and facility capabilities and capacities, and to schedule required materials.

Maintenance personnel can:

- Assess the maintenance workload capacity by analyzing the available labor based on skill, level and certification, available tools, materials, and location capabilities balanced against known workloads.

- Create a visit to group events together for long and short term capacity planning, and to facilitate scheduling to a maintenance base.

- Select serialized items and reserve them for a specific task in a visit.

- Define the visit resource requirements to enable accurate scheduling and capacity planning.

- Analyze capacity versus workload requirements.

- Run simulations to evaluate different scheduling scenarios before implementing actual plan changes.

Long Term Planning maximizes maintenance scheduling by balancing the maintenance requirements with available maintenance capacity. The maintenance planner can
balance the forecasted maintenance requirement information from the unit maintenance plan against projected maintenance capacity.

By using serial number reservations, the maintenance planner can provide a global view of material requirements that identifies material availability at the required location and date for items associated on counter values. This reduces aircraft down times and increase the life expectancy of subcomponents. Serial number reservations are set up in Oracle Inventory.

For more information regarding long term planning, refer to the Oracle Complex Maintenance, Repair and Overhaul User’s Guide and Oracle Planning

Setting up the Long Term Planning module includes defining the lookup values as indicated below.

**To define lookups for Long Term Planning**

1. Access the Application Developer responsibility.


3. Define the lookups as outlined in this table.

<table>
<thead>
<tr>
<th>Attribute</th>
<th>Lookup</th>
<th>Suggested Values</th>
<th>Access Level</th>
</tr>
</thead>
<tbody>
<tr>
<td>Category</td>
<td>AHL_LTP_SPACE/category</td>
<td>Category 1, Category 2…</td>
<td>Extensible</td>
</tr>
<tr>
<td>Display Only</td>
<td>AHL_LTP_VISITS/SCHEDULED</td>
<td>Scheduled, Unscheduled</td>
<td>Extensible</td>
</tr>
<tr>
<td>Status</td>
<td>AHL_LTP_SPACE_STATUS</td>
<td>Inactive, Active</td>
<td>Extensible</td>
</tr>
<tr>
<td>Visit Type</td>
<td>AHL_PLANNING_VISIT TYPE</td>
<td>A-Check, B-Check, C-Check</td>
<td>User</td>
</tr>
</tbody>
</table>
Application Object Library Lookups

<table>
<thead>
<tr>
<th>Type</th>
<th>Visit Display Only</th>
<th>Access Level</th>
<th>Enabled</th>
</tr>
</thead>
<tbody>
<tr>
<td>Meaning</td>
<td>Visits Display Only</td>
<td>User</td>
<td></td>
</tr>
<tr>
<td>Application</td>
<td>Complex Maintenance Repair</td>
<td>Extensible</td>
<td></td>
</tr>
<tr>
<td>Description</td>
<td>and Overhaul</td>
<td>System</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Cost</th>
<th>Meaning</th>
<th>Description</th>
<th>Tag</th>
<th>From</th>
<th>To</th>
<th>Enabled</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>Scheduled Visits</td>
<td>Scheduled Visits</td>
<td>22-MAY-2002</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>1</td>
<td>Unscheduled Visits</td>
<td>Unscheduled Visits</td>
<td>22-MAY-2002</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>2</td>
<td>Visits with conflict</td>
<td>Visits with conflicting</td>
<td>19-MAY-2003</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Setting Up Production

The Production module enables the execution of routine and non-routine tasks associated with a visit. It also supports the execution of tasks against an Installed Base Tracked Item.

Maintenance personnel can:

- Search for routine and non-routine jobs using filtered search elements.
- Create jobs from visit tasks for Scheduled, Unscheduled, and Convenience maintenance.
- Create service requests to track reported problems when an item has a service difficulty.
- Create operations to non-routine jobs for work definition and tracking.
- Maintain jobs by adjusting the schedule, the status, completing, deferring, and selecting the actual start and end for a job.
- Maintain operations by updating the operations, adding, removing, or updating the material and resource requirements.
- Maintain Quality using the route setup from Route Management for job and operation compliance.
Maintenance scheduler can create jobs, initiate service for material and parts change transactions, and perform job operation maintenance.

Setting up the Production module includes:

- Setting up system profile options.
- Defining lookups.

To set up System Profile Options:

1. Navigate to the System Profile Values page (System Administrator > Profile > System > System Profile Values).

2. Set up the system profile options as described in this table.

<table>
<thead>
<tr>
<th>Profile</th>
<th>Site (Value)</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>AHL: Job Deferral Inspection Type</td>
<td>Deferral Approval</td>
<td>The Quality plan inspection type used for Production Job deferrals.</td>
</tr>
<tr>
<td>AHL: MRB Disposition Inspection</td>
<td>MRB Approval Required</td>
<td>The Quality plan inspection type used when a tracked item is returned an MRB subinventory.</td>
</tr>
<tr>
<td>AHL: Material Status - MRB</td>
<td>Active/Non-Active</td>
<td>The status that triggers the Quality inspection requirement for MRB and a service request creation, when an tracked item is being returned in the condition associated with this status to a subinventory with the status associated.</td>
</tr>
<tr>
<td>AHL: Material Status - Serviceable</td>
<td>Active</td>
<td>The status indicating a serviceable item. This status is used to ensure that installed items meet the condition associated with this status and are issued from a subinventory with this status associated.</td>
</tr>
<tr>
<td>Profile</td>
<td>Site/Value</td>
<td>Description</td>
</tr>
<tr>
<td>---------</td>
<td>------------</td>
<td>-------------</td>
</tr>
<tr>
<td>AHL: Material Status - Unserviceable</td>
<td>Active</td>
<td>The status that triggers the Service Request creation, when a tracked item is being returned in the condition associated with this status to a subinventory with the status associated.</td>
</tr>
<tr>
<td>AHL: Non-Routine Operation Inspection</td>
<td>-</td>
<td>Used to determine if non-routine operation required inspection.</td>
</tr>
<tr>
<td>AHL: OE Mixed Order Type ID</td>
<td>P-Mixed</td>
<td>Order type to create a OSP order.</td>
</tr>
<tr>
<td>AHL: OE Return Line ID</td>
<td>P-Return</td>
<td>Line type to create a OSP order.</td>
</tr>
<tr>
<td>AHL: OE Ship Only Line Type ID</td>
<td>P-Standard</td>
<td>Line type to create a OSP standard only ship line.</td>
</tr>
<tr>
<td>AHL: Validate Alternate Items</td>
<td>Yes/No</td>
<td>Enabled/disable organization validation on alternate items for UC.</td>
</tr>
</tbody>
</table>

**System Profile Values**

<table>
<thead>
<tr>
<th>Profile Option Name</th>
<th>Site</th>
<th>Application</th>
<th>Responsibility</th>
<th>User</th>
</tr>
</thead>
<tbody>
<tr>
<td>AHL: Job Default Inspection Type</td>
<td></td>
<td>External Approval</td>
<td></td>
<td></td>
</tr>
<tr>
<td>AHL: MRB Disposition Inspection Type</td>
<td></td>
<td>MRB Appraisal Required</td>
<td></td>
<td></td>
</tr>
<tr>
<td>AHL: Material Status - MRB</td>
<td></td>
<td>Active</td>
<td></td>
<td></td>
</tr>
<tr>
<td>AHL: Material Status - Sensitive</td>
<td></td>
<td>Active</td>
<td></td>
<td></td>
</tr>
<tr>
<td>AHL: Material Status - Unsensitive</td>
<td></td>
<td>Active</td>
<td></td>
<td></td>
</tr>
<tr>
<td>AHL: Non-Routine Operation Inspection</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>AHL: Validate Recipient to Material</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>AHL: Vendor Service Duration</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>AHL: Visit Stage Number</td>
<td>10</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>AHL: Warranty Expiration Threshold</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**To define lookups for Production:**

1. Access the Application Developer responsibility.

3. Define the lookups as outlined in this table.

<table>
<thead>
<tr>
<th>Attribute</th>
<th>Lookup</th>
<th>Suggested Values</th>
<th>Access Level</th>
</tr>
</thead>
<tbody>
<tr>
<td>Display Only</td>
<td>AHL_LTP_VISITS_DISPLAY_ONLY</td>
<td>Scheduled, Unscheduled</td>
<td>Extensible</td>
</tr>
<tr>
<td>Status</td>
<td>AHL_LTP_SPACE_STATUS</td>
<td>Inactive, Active</td>
<td>Extensible</td>
</tr>
<tr>
<td>Visit Type</td>
<td>AHL_PLANNING_VISIT_TYPE</td>
<td>A-Check, B-Check, C-Check</td>
<td>User</td>
</tr>
</tbody>
</table>

Setting Up Inventory Service Order Outside Processing

In the airline industry, defective parts are often removed, and put in an unserviceable inventory location, before the work order is created. Oracle Inventory service orders enable you to create orders for items directly from an inventory location, without creating a visit and a work order. This process is automated using default data. The features of inventory service orders for outside processing:
• Automatic service orders are created with shipping information for selected items.

• Vendor and service sourcing rules are defined based on the item and item location.

• Relationship between the vendor information and the customer information is defined.

• Vendors can be identified as providing Warranty Service.

• Service Orders can include Warranty Contracts, Terms and Conditions.

• Both serialized and non-serialized items in inventory can be selected for the creation of a service order.

• Create and maintain attachments.

• Ability to convert service order into an exchange order.

**Setup and Process Flow for Inventory Service Order Outside Processing**

This diagram illustrates the setup steps and process flow for the Inventory Service Order Outside Processing feature:
Prerequisites

These are the prerequisites required in order to use the Inventory service order outside processing functionality:

- Set up profile options to create default information to automate the creation of service orders.
- Define outside processing service (OSP) vendors.
- Define part, service and vendor relationships.
• Define vendors and customer relationships.
• Define customer shipping defaults.

Profile Options Setup

The profile options setup includes:

<table>
<thead>
<tr>
<th>Profile</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>AHL:Service Order Default Shipment Priority</td>
<td>The default shipment priority used to create the shipping information for a service order in outside processing. The value is selected from available shipment priorities defined. If this profile option is not set, the value must be selected manually.</td>
</tr>
<tr>
<td>AHL:OM Tax Exempt Reason</td>
<td>The tax exempt reason used to create a tax exempt sales order and is used for shipping purposes. This value is required for creating shipping information.</td>
</tr>
<tr>
<td>AHL:Vendor Service Duration</td>
<td>The service duration used to calculate the turnaround time for a part sent out for a service. This profile option defines a default service duration used in the calculation if no specific duration has been defined. The unit of measure is days.</td>
</tr>
<tr>
<td>AHL:OM Shipment Priority</td>
<td>The default value for the shipment priority used to create an inventory service order with shipping information.</td>
</tr>
<tr>
<td>AHL:OM Line Return Reason</td>
<td>The default value for the return reason of a shipment return line used to create an inventory service order with shipping information.</td>
</tr>
<tr>
<td>AHL:OM Mixed Order Type ID</td>
<td>The Order Management order type for the shipping information. Used to automatically create the order in the background.</td>
</tr>
<tr>
<td>AHL:OM Ship Only Line Type ID</td>
<td>The Order Management line type for the shipment line. It is used to automatically create the order in the background.</td>
</tr>
</tbody>
</table>
### Profile

<table>
<thead>
<tr>
<th>Profile</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>AHL:OM Return Line Type ID</td>
<td>The Order Management line type for the return line. It is used to automatically create the order in the background.</td>
</tr>
<tr>
<td>AHL:Service Order Ship IB Transaction SubType</td>
<td>The type used by Oracle Installed Base customers providing the ability to define customer specific transaction subtypes for shipping transactions.</td>
</tr>
<tr>
<td>AHL:Service Order Return IB Transaction SubType</td>
<td>The transaction subtype used by Oracle Installed Base customers providing the ability to define customer specific transaction subtypes for return transactions.</td>
</tr>
<tr>
<td>AHL:Exchange Order Ship IB Transaction SubType</td>
<td>The transaction subtype used by Oracle Installed Base customers providing the ability to define customer specific transaction subtypes for exchange orders.</td>
</tr>
<tr>
<td>AHL:Exchange Order Return IB Transaction SubType</td>
<td>The transaction subtype used by Oracle Installed Base customers providing the ability to define customer specific transaction subtypes for exchange order returns.</td>
</tr>
<tr>
<td>AHL:Overwrite PO line description with Item/Serial Number</td>
<td>The part number and serial number of the service item on the purchase order.</td>
</tr>
<tr>
<td>AHL:PO line description Item number prefix</td>
<td>The item number in the description of the service item on the purchase order.</td>
</tr>
<tr>
<td>AHL:PO line description Serial number prefix</td>
<td>The serial number in the description of the service item on the purchase order.</td>
</tr>
<tr>
<td>AHL:PO Line Type ID</td>
<td>The default PO Line Type created when a purchase order is created.</td>
</tr>
<tr>
<td>AHL:OSP Default PO Distribution Creation</td>
<td>Indicates whether the PO creation process creates the default accounting distribution when submitting a purchase order from OSP.</td>
</tr>
</tbody>
</table>

### Related Topics

Managing Outside Processing, *Oracle Complex Maintenance, Repair and Overhaul User’s*
Administrative Setup

Using the Administration link, you can manage administrative functions related to the Visit Work Package and Long Term Planning modules.

Users can:

- Create department shifts.
- Define maintenance spaces and determine space unavailability.
- Use the Reliability Planning feature to reduce inventory levels at maintenance facilities and transient stations.

The Reliability Planning functionality is set up in Oracle Inventory and Oracle Planning.

Department shifts are created to define the working hours of a maintenance department. These shifts are used to calculate the start time of the tasks in a scheduled visit.

To set up department shifts:

1. From the Manufacturing and Distribution Manager responsibility, navigate to Oracle Bills of Material >Setup > Calendars. The Workday Calendar window appears. Define a BOM calendar.
2. Click the Shifts button to define shifts for the calendar.
3. Click Workday Pattern to navigate to the Shift Workday Patterns window. Enter the workdays for the shift.
Defining Workday Patterns

The Calendar, Shift Number and Workdays values defined will be available in the corresponding list of values when creating department shifts in the Oracle CMRO application. For information on creating department shift records, refer to the Oracle Complex Maintenance, Repair, and Overhaul User's Guide.

Setting Up Enigma Integration

Oracle CMRO delivers the total functionality for maintenance organizations to successfully manage all the maintenance operations from configuration management and engineering to maintenance planning and execution.

Enigma 3C ® delivers a dynamic service index of maintenance, parts and diagnostic information that captures operational expertise and connects to vital corporate systems to manage and optimize the service and support workflow.

The integration between Oracle CMRO and Enigma 3C provides maintenance service providers with a set of tools that connects the configuration management, engineering and maintenance planning functionality contained in CMRO with the Enigma documentation centric maintenance execution system in a wireless environment.

The Enigma integration performs the following:

- Associate Aircraft Maintenance Manual (AMM) Tasks to Route Management
- Associate Enigma Configuration Information to Master Configuration
- Associate Enigma Configuration Information to Unit Configuration
Profile Options Setup

The setup profiles include:

<table>
<thead>
<tr>
<th>Profile</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>AHL: Enigma AMM Documents associated</td>
<td>The AMM (Aircraft Maintenance Manual) task cards are associated with a route in CMRO. If the profile is set to No, you cannot associate documents from Enigma.</td>
</tr>
<tr>
<td>AHL: Enigma WDM Documents associated</td>
<td>A maintenance technician can view associated Enigma documents related to a maintenance work order. If this profile is set to No, the associated Enigma documents cannot be viewed.</td>
</tr>
<tr>
<td>AHL: Enigma IPC Documents associated</td>
<td>A maintenance technician can view associated Enigma documents related to a maintenance work order. If this profile is set to No, the associated Enigma documents cannot be viewed.</td>
</tr>
<tr>
<td>AHL: Enigma EM Documents associated</td>
<td>A maintenance technician can view associated Enigma documents related to a maintenance work order. If this profile is set to No, the associated Enigma documents cannot be viewed.</td>
</tr>
<tr>
<td>CMRO Enigma Integration URL</td>
<td>A configuration manager can retrieve, view and associate Enigma 3C content at a master configuration header level. If the profile is set to No, the Enigma Documents region will not appear.</td>
</tr>
</tbody>
</table>

Overview of Associating Aircraft Maintenance Manual (AMM) Tasks to Route Management

The AMM (Aircraft Maintenance Manual) task cards are associated with a route in CMRO. These task cards include the content from AMM, IPC, and WDM manuals. CMRO will maintain the revision of the tasks and will also store a PDF file as an attachment to the route. Oracle CMRO performs the following setup steps for this functionality:

- Provides a concurrent program to create draft route templates and associate a PDF
file to route templates based on the Enigma content.

- Provides a concurrent program to create notifications based on the Enigma XML file with revised task content.
- Calls the Enigma URL and passes the AMM key parameters to Enigma.
- Provides a web service to accept the document parameters from Enigma and create a document association within CMRO.
- Builds the functionality to store the Enigma document as a PDF file.
- Builds a user interface to view the Enigma AMM task association and calls the Enigma URL to view document content.

**Overview of Associating Enigma Configuration Information to Master and Unit Configurations**

You can look up configuration information in the Enigma 3C application and associate it to a CMRO master configuration. Use this association to view the document content in the Unit Configuration and Production modules. Oracle CMRO performs the following setup steps for this functionality:

- Calls Enigma URL and passes the AIPC, EM, or WDM key parameters to Enigma.
- Provides a web service to accept the document parameters.
- Builds the functionality to store the Enigma document association as a PDF file.
- Builds a user interface to view the Enigma AIPC association and calls the URL for document content viewing.
- Provides the user interface to view associated documents in the Unit Configuration module.

**Overview of Viewing and Printing Enigma Content in CMRO Execution Module**

A maintenance technician can view and print the associated Enigma documentation for a specific work order in CMRO. When detecting a defect, the maintenance technician can view the Fault Identification Manual (FIM) troubleshooting. Oracle CMRO performs the following setup steps for this functionality:

- Provides the user interface to view and print the Enigma documents associated with work orders.

**Setting Up Supplier Warranty**

Oracle CMRO delivers functionality for maintenance organizations to successfully manage warranty on traceable items throughout their lifecycle through the use of
Warranty Templates and their associated Warranty Contracts.

Setting up Supplier Warranty includes:

- Defining a Warranty Type lookup value. This value is a required value in a Warranty Template and Warranty Contract record and provides a helpful method for filtering Warranty Templates and Contracts in several search pages.

- Identifying Vendors who can provide warranty service. A flag is set on the Vendor record, controlling visibility in the Vendor list of value lookups in several Warranty pages. Vendor is also a required attribute in a Warranty Template and Warranty Contract record.

- Creating contracts for existing traceable inventory items.

- Setting up Notifications. Notifications are used to alert you to changes in warranty status, completion of warranty work, expiring warranty contracts and the automatic creation of new contracts.

- Scheduling concurrent programs. Warranty expirations and auto-creation of warranty contracts must be setup and scheduled in order to assist the Warranty Administration user.

To define lookups for supplier warranty

1. Login using the Application Developer Responsibility.

2. Navigate to the Lookups window and define the lookups as indicated in the following table.

<table>
<thead>
<tr>
<th>Attribute</th>
<th>Lookup</th>
<th>Suggested Values</th>
<th>Access Level</th>
</tr>
</thead>
<tbody>
<tr>
<td>Warranty Type</td>
<td>AHL_WARRANTY_TYPE</td>
<td>Aircraft OEM, Engine OEM, Component OEM, Aircraft MRO, Engine MRO, Component MRO, 3rd Party</td>
<td>User</td>
</tr>
</tbody>
</table>
To define vendors for warranty service

1. Login using the Super User or equivalent responsibility.

2. Navigate to the Administration Module, Vendor Sourcing Tab, and Vendors Sub-Tab.

3. For each Vendor, check the Warranty Flag to indicate they have the ability to provide Warranty Service.
4. Click Apply to save the record.

Overview of Warranty Notifications

Oracle CMRO provides several notifications for managing Supplier Warranty.

- **Change to Warranty Entitlement Acceptance/Rejection** - When a Technician makes changes to a Warranty Entitlement record on a work order, the Warranty Administrator receives a notification of the changes. The Administrator can accept or reject the changes using the Warranty Entitlements pages.

- **Warranty Review** - When a Technician requests review of the Warranty Entitlement on a work order, the Warranty Administrator receives a notification. The Administrator manages the review by using the Warranty Entitlements page.

- **Warranty Expirations** - A scheduled concurrent program generates a report of all warranty contracts that are expiring in a user-defined time period (such as within 60 days from system date). This report is sent via notification to selected users.

- **Autocreation of Warranty Contracts** - A scheduled concurrent program generates warranty contracts for any applicable item instances that are introduced into CMRO. An accompanying report is sent via notification to selected users.

Overview of Creating Contracts for Existing Traceable Inventory Items

Existing inventory must be assigned warranty contracts if they are still covered by applicable warranty terms and conditions from a supplier. It is recommended that you setup warranty templates for each supplier, terms and conditions statement and associated item(s). You can either manually define warranty contracts for each item
instance or run the autocreate concurrent program to generate contracts in a pending status. Each of these contracts can be manually reviewed and the status updated as applicable.

For warranty contracts to be accurately generated, you must establish the following in the relationships between a warranty template and an item instance:

- Item must match and be correctly enabled in the Warranty Template.
- If counter controlled, the corresponding counter must be added to the Warranty Template.

**Overview of Warranty Related Concurrent Programs**

Oracle CMRO provides several concurrent programs for assistance:

- **Warranty Expiration**: This program must be run daily or weekly to recalculate the expiration dates of each warranty contracts.

  This program also generates a report and corresponding notification of the expiring contracts during the user-defined period, such as 60 days. The program can be manually run for an item instance to provide the most current expiration calculation.

- **Warranty Contract Autocreate**: This program should be run weekly to create new contracts for applicable item instances that are created in Oracle Installed Base.

  This process creates new contacts, based on items that have an enabled warranty template, in a pending status. A report of each new contract is viewed via a notification to you, allowing you to be manually reviewed and enabled.
Windows and Navigation Paths

This appendix covers the following topics:

• Windows and Navigation Paths
• Default Navigation Paths for Standard Application Windows

Windows and Navigation Paths

This appendix provides the default navigator paths for the windows used in the Oracle Complex Maintenance, Repair, and Overhaul (CMRO). The following table provides the default navigation paths. Brackets [ ] indicate a button.

Default Navigation Paths for Standard Application Windows

<table>
<thead>
<tr>
<th>Window Name</th>
<th>Navigation Path</th>
</tr>
</thead>
<tbody>
<tr>
<td>Accounting Information</td>
<td>Manufacturing and Distribution Manager: Inventory &gt; Setup &gt; Organizations &gt; Inventory Organization &gt; Others &gt; Accounting Information</td>
</tr>
<tr>
<td>Additional Organization Information</td>
<td>Manufacturing and Distribution Manager: Inventory &gt; Setup &gt; Organizations &gt; Organizations &gt; HR Organization &gt; Others</td>
</tr>
<tr>
<td>Application Object Library Lookups</td>
<td>Application Developer: Application &gt; Lookups &gt; Application Object Library</td>
</tr>
<tr>
<td>Application Object Library: JTF_RS_ROLE_TYPE Lookups</td>
<td>CRM Resource Manager: Setup &gt; Role Types</td>
</tr>
<tr>
<td>Window Name</td>
<td>Navigation Path</td>
</tr>
<tr>
<td>---------------------------------</td>
<td>---------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Approval Groups</td>
<td>Manufacturing and Distribution Manager: Purchasing &gt; Setup &gt; Approvals &gt; Approval Groups</td>
</tr>
<tr>
<td>Buyers</td>
<td>Manufacturing and Distribution Manager: Purchasing &gt; Setup &gt; Personnel &gt; Buyers</td>
</tr>
<tr>
<td>Category Sets</td>
<td>Enterprise Asset Management: Set up &gt; Category &gt; Category Sets</td>
</tr>
<tr>
<td>Collection Elements</td>
<td>Manufacturing and Distribution Manager: Quality &gt; Setup &gt; Collection Elements</td>
</tr>
<tr>
<td>Collection Plans</td>
<td>Manufacturing and Distribution Manager: Quality &gt; Setup &gt; Collection Plans</td>
</tr>
<tr>
<td>Department Classes</td>
<td>Manufacturing and Distribution Manager: Bill of Materials &gt; Setup &gt; Department Classes</td>
</tr>
<tr>
<td>Department Subinventories</td>
<td>Warehouse Manager Mgmt Super User: Setup &gt; Warehouse Configuration &gt; Resources &gt; Associate Departments &amp; Subinventories</td>
</tr>
<tr>
<td>Departments</td>
<td>Manufacturing and Distribution Manager: Bill of Materials &gt; Routings &gt; Department</td>
</tr>
<tr>
<td>Enterprise Asset Management Parameters</td>
<td>Enterprise Asset Management: Setup &gt; Parameters</td>
</tr>
<tr>
<td>Exp Org Defaults</td>
<td>Manufacturing and Distribution Manager: Inventory &gt; Setup &gt; Organizations &gt; Project Expenditure/Event Organization &gt; Others</td>
</tr>
<tr>
<td>Find Buyer</td>
<td>Contract Manager: Setup &gt; Others &gt; Buyer &gt; Buyer</td>
</tr>
<tr>
<td>Find Categories</td>
<td>Enterprise Asset Management: Set up &gt; Category &gt; Category Codes</td>
</tr>
<tr>
<td>Find Organization window</td>
<td>Manufacturing and Distribution Manager: Inventory &gt; Setup &gt; Organizations &gt; Organizations</td>
</tr>
<tr>
<td>Window Name</td>
<td>Navigation Path</td>
</tr>
<tr>
<td>--------------------------------</td>
<td>---------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Find System Profile Values</td>
<td>System Administrator &gt; Profile &gt; System</td>
</tr>
<tr>
<td>Find/Enter Customers</td>
<td>Manufacturing and Distribution Manager: Order Management: Customers &gt; Standard</td>
</tr>
<tr>
<td>Installed Parameters</td>
<td>Oracle Installed BaseAdmin &gt; Setup &gt; Install Parameters</td>
</tr>
<tr>
<td>Instance Statuses</td>
<td>Oracle Installed BaseAdmin &gt; Setup &gt; Instance Statuses</td>
</tr>
<tr>
<td>Inventory Accounting Periods</td>
<td>Manufacturing and Distribution Manager: Inventory &gt; Accounting Close Cycle &gt;</td>
</tr>
<tr>
<td></td>
<td>Inventory Accounting Periods</td>
</tr>
<tr>
<td>Key Flexfields Segments</td>
<td>Application Developer: Flexfield &gt; Key &gt; Segments</td>
</tr>
<tr>
<td>Master Item</td>
<td>Manufacturing and Distribution Manager: Inventory &gt; Items &gt; Master Items</td>
</tr>
<tr>
<td>Material Status Definition</td>
<td>Warehouse Manager Mgmt Super User: Setup &gt; Transaction Setup &gt; Inventory</td>
</tr>
<tr>
<td></td>
<td>Transactions &gt; Material Status</td>
</tr>
<tr>
<td>M and O Procedures</td>
<td>MRO&gt;Engineering&gt;MEL/CDL&gt;Overview&gt;Create&gt;Update MEL Node&gt;(M) and (O) Procedures</td>
</tr>
<tr>
<td>Open and Close Periods</td>
<td>Manufacturing and Distribution Manager: Purchasing &gt; Financial &gt; Accounting &gt; Open</td>
</tr>
<tr>
<td></td>
<td>and close periods</td>
</tr>
<tr>
<td>Oracle Manufacturing Lookups</td>
<td>Enterprise Asset Management: Setup &gt; Lookup</td>
</tr>
<tr>
<td>Organization Parameters</td>
<td>Manufacturing and Distribution Manager: Inventory &gt; Setup &gt; Organizations &gt;</td>
</tr>
<tr>
<td></td>
<td>Inventory Organization &gt; Others &gt; Inventory Information</td>
</tr>
<tr>
<td>Window Name</td>
<td>Navigation Path</td>
</tr>
<tr>
<td>------------------------------------</td>
<td>--------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Parent Organization</td>
<td>Manufacturing and Distribution Manager: Inventory &gt; Setup &gt; Organizations &gt; Organizations &gt; HR Organization &gt; Others &gt; Parent organization</td>
</tr>
<tr>
<td>Personal Profile Values</td>
<td>Application Developer &gt; Other &gt; Profile</td>
</tr>
<tr>
<td>Processing Constraints</td>
<td>Manufacturing and Distribution Manager: Order Management &gt; Set Up &gt; Rules &gt; Security &gt; Processing Constraints</td>
</tr>
<tr>
<td>Project Manufacturing Parameters</td>
<td>Manufacturing and Distribution Manager: Inventory &gt; Setup &gt; Organizations &gt; Project Manufacturing Organization &gt; Others</td>
</tr>
<tr>
<td>Project Parameters</td>
<td>Manufacturing and Distribution Manager: Project &gt; Project Definitions &gt; Project Parameters</td>
</tr>
<tr>
<td>Project Type Class Information</td>
<td>Manufacturing and Distribution Manager: Inventory &gt; Setup &gt; Organizations &gt; Project Task Owning Organization &gt; Others &gt; Project Type Class Information</td>
</tr>
<tr>
<td>Resources</td>
<td>Manufacturing and Distribution Manager: Bill of Materials &gt; Routings &gt; Resources</td>
</tr>
<tr>
<td>Roles</td>
<td>CRM Resource Manager: Setup &gt; Roles</td>
</tr>
<tr>
<td>Search Approval Rules</td>
<td>Advanced Service Online User: Administration &gt; Approvals</td>
</tr>
<tr>
<td>Segment Values</td>
<td>Application Developer: Flexfield &gt; Key &gt; Values</td>
</tr>
<tr>
<td>Selection Criterion</td>
<td>CRM Resource Manager: Maintain Resources &gt; Import Resources</td>
</tr>
<tr>
<td>Service Request Severities</td>
<td>Customer Support: Setup &gt; Service Request &gt; Request Severities</td>
</tr>
<tr>
<td>Window Name</td>
<td>Navigation Path</td>
</tr>
<tr>
<td>--------------------------------</td>
<td>--------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Service Request Statuses</td>
<td>Customer Support: Setup &gt; Service Request &gt; Request Status</td>
</tr>
<tr>
<td>Service Request Types</td>
<td>Customer Support: Setup &gt; Service Request &gt; Request Types</td>
</tr>
<tr>
<td>Setup Counters</td>
<td>Field Service Manager: Field Service Setup &gt; Counters &gt; Define Counters</td>
</tr>
<tr>
<td>Subinventories</td>
<td>Manufacturing and Distribution Manager: Inventory &gt; Setup &gt; Organization &gt; Subinventories</td>
</tr>
<tr>
<td>Subinventories Summary</td>
<td>Warehouse Manager Mgmt Super User: Setup &gt; Warehouse Configuration &gt; Warehouse &gt; Subinventories</td>
</tr>
<tr>
<td>Suppliers</td>
<td>Contract Manager: Setup &gt; Others &gt; Supplier &gt; Entry</td>
</tr>
<tr>
<td>WIP Accounting Classes</td>
<td>Enterprise Asset Management: Setup &gt; WIP &gt; WIP Accounting Classes</td>
</tr>
<tr>
<td>WIP Accounting Classes</td>
<td>Manufacturing and Distribution Manager: WIP &gt; Setup &gt; WIP Accounting Class</td>
</tr>
<tr>
<td>Work in Process Parameters</td>
<td>Manufacturing and Distribution Manager: Inventory &gt; Setup &gt; Organizations &gt; WIP Organization &gt; Others</td>
</tr>
<tr>
<td>Workflow Process Mapping</td>
<td>Advanced Service Online User: Administration &gt; Workflow</td>
</tr>
</tbody>
</table>
A
administrative setup, 2-132
Approval Workflow
  approval users and roles definition, 2-77
  automatic visit scheduling, 2-86
Auto Visit Planning
  visit type profiles, defining, 2-90
Auto Visit Planning, overview, 1-3

B
Bill of Materials
  departments and resources setup, 2-36

C
CMRO
  standard setup, 2-73
CMRO Modules
  unit configurations, setting up, 2-109
CMRO Modules Setup
  Document Index, 2-99
  Fleet Maintenance Program, 2-115
  Long Term Planning, 2-122
  Master Configuration, 2-107
  Production, 2-124
  Route Management, 2-101
  Unit Maintenance Plan, 2-117
  Visit Work Package, 2-119
Complex Assembly Maintenance
  prerequisites, 2-96
  setting up, 2-96
  configuration access control
  allowed transactions, 2-109
Contracts
  buyers setup, 2-62
  suppliers setup, 2-62
Counters
  counter groups definition, 2-66

E
Enigma integration, setting up, 2-135

F
fleet forecasting
  service categories, defining, 2-87
  flight categories
    defining, 2-88

I
Inventory
  component items setup, 2-25
  service items setup, 2-25
  subinventory setup, 2-25

L
Lookups
  Document Index, 2-99
  Enterprise Asset Management, 2-53
  Fleet Maintenance Program, 2-115
  Long Term Planning, 2-122
  Master Configuration, 2-107
  Production, 2-124
  Route Management, 2-101
Visit Work Package, 2-119

M
Max Service Category, setting up, 2-87
MRs, primary
defining, 2-91

O
Oracle Applications setup
Warehouse Management, 2-39
Order Management
customer definition, 2-49
processing constraints setup, 2-49
Organization Setup
creating
organization, 2-8
setting up
inventory organization, 2-8
operating unit, 2-8
Other Oracle Applications Setup
Bills of Material, 2-36
Contracts, 2-62
Counters, 2-66
Enterprise Asset Management, 2-53
Installed Base, 2-64
Inventory, 2-25
Order Management, 2-49
Project, 2-51
Purchasing, 2-44
Quality, 2-66
Service, 2-56

P
Profile Options
Approval Workflow
AHL: Enable approval workflow for
Maintenance Requirement, 2-77
AHL: Enable approval workflow for
Routes, 2-77
AHL: Workflow Loop Counter, 2-77
AHL: Workflow Timeout Minutes, 2-77
CMRO General Setup
AHL: Preventive Maintenance
Installation, 2-73
AHL: Turn On Development Debug, 2-73

AHL: Turn on File Debug, 2-73
Production
AHL: Job Deferral Inspection Types, 2-124
AHL: Material Status-Serviceable, 2-124
AHL: Material Status-Unserviceable, 2-124
AHL: MRB Disposition Inspection, 2-124
AHL: Non-routine Operation Inspection, 2-124
AHL: OE Mixed Order Type ID, 2-124
AHL: OE Return Line ID, 2-124
AHL: OE Ship Only Line Type ID, 2-124
AHL: Validate Alternate Items, 2-124
Quality
AHL: Counter Reading Plan, 2-71
AHL: Job Deferral Inspection type, 2-70
AHL: MRB Disposition Inspection Type, 2-70
AHL: Non-routine Job Inspection Type, 2-70
AHL: Non-routine Operation Inspection Type, 2-70
Service
AHL: Default SR Customer Name, 2-56
AHL: Default SR Severity, 2-56
AHL: Default SR Status, 2-56
AHL: Default SR Type, 2-56
Unit Maintenance Plan
AHL: Consider Department Conflicts, 2-117
AHL: Maximum Planning Window
(Number), 2-117
AHL: Maximum Planning Window
(UOM), 2-117
AHL: Minimum maintenance
opportunity duration in minutes
required for scheduling a visit, 2-117
Visit Work Package
AHL: Default Project Template ID, 2-119
Warehouse Management
AHL: Material Status-MRB, 2-39
AHL: Material Status-Serviceable, 2-39
AHL: Material Status-Unserviceable, 2-39

Profile OptionsProductionAHL: Validate
Alternate Items
Profile Options
Production
AHL: Material Status, 2-124

Project
project template definition, 2-51

Q
Quality
quality plans setup, 2-66

S
Service
  service request severity definition, 2-56
  service request status definition, 2-56
  service request type definition, 2-56
setting up
  service categories, 2-87
space categories, defining, 2-87
supplier warranty
  setting up, 2-137

U
unit configurations, setting up, 2-109

V
visit type profiles
  defining, 2-90

W
Warehouse Management
  associate departments with subinventories, 2-39
  associate material status with subinventories,
  2-39
  material status definition, 2-39
WIP Accounting Classes
  asset non-standard, 2-53
  expense, 2-53
  maintenance, 2-53
  standard, 2-53